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1 INTRODUCTION m .

1 INTRODUCTION

1.1 About the PROCESS DATA ANALYZER

The PROCESS DATA ANALYZER (PDA) is an application software for the recording and
graphical display of control signals, position data, status information and sensor measured
values, which can be managed by the RAYLASE SP-ICE-3 control card.

These are mainly:

® Position data that the control card sends to the deflection unit.

®m  Control signals for lasers of the control card.

® Sent/Received IO signals.

B Position data measured at the deflection unit.

® Other signals / data recorded at the deflection unit.

® Signals from external sensors that are fed in via the control card interfaces.

Therfore, the data from the trace buffer of the control card is read and visualized and/or
saved.

B The primary task of the GUIl-based PROCESS DATA ANALYZER application is the
visualization of the signals / data in order to evaluate them in relation to each other.

® There is also a PROCESS DATA ANALYZER software development kit (SDK), which enables
automated data recording.

IMPORTANT: At no time does the PDA software actively intervene in the laser processing or
influence it in any way.

1.2 Compatibility
The PDA software is compatible with the RAYLASE SP-ICE-3 control card.

A PDA instance can only connect it with a control card.

In principle, it is possible to have several instances of the PDA software open at the same
time.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 6



1 INTRODUCTION m .

1.3 Performance features

® Temporal display of all selected signals (comparable to a digital oscilloscope).
m Each selected signal can be displayed spatially resolved in an XY diagram.

®  Coupled cursor: The cursor position in the XY diagram follows the cursor in the time
diagram.

Position data of the optical axes can be displayed in both the field and scanner domains.
Display of actual position data or status information of deflection units.

Flexible color design of XY diagrams.

Virtual signals possible for visualising mathematical relationships between signals (e.g.
positioning speed).

® MOTF counter-compensation for analysing the vector positions for component reference in
MOTF processes.

® Two cursors for measuring times.
® Measurement tools for measuring distances.

m Flexible GUI design thanks to the panel method. This allows, for instance, two XY diagrams
to be arranged next to each other.

B Various trigger functions for controlling the start and end of a recording.
B Timer for time-controlled termination of recording to prevent memory overflow.
®  Choice between white and dark GUI background color.

m Software development kit (SDK) for carrying out automated data recording or data
backups.

1.4 Scope of delivery

The following components are included in the scope of delivery:
® PROCESS DATA ANALYZER software installation file

Required to install all program and library files needed for the PROCESS DATA ANALYZER
application

NOTE: The installation file (*.msi) can only be downloaded via RAYBOARD PRODUCT
INSTALLER

® PROCESS DATA ANALYZER user manual in PDF form (DE, EN)
B License agreement as PDF file (DE, EN)

B Programming manual for PROCESS DATA ANALYZER SDK as CHM file (for programmable
interface, EN)

®m Optional hardware dongle as license carrier.

Not included in the standard scope of delivery is a ADC Adapter board for converting analog
measurement signals to a digital input of the control card.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 7



1 INTRODUCTION m .

1.5 About this Manual

This manual describes the entire functionality and performance features of the PROCESS
DATA ANALYZER software when used with the graphical user interface (GUI).

Conventions

® Emphasized phrases are printed in bold.

® |mportant notes and remarks are introduced with NOTE:, RULE:, etc.

® Folder and file names are printed in italics.

B The names of windows, dialogues and tabs are given as normal text: On the Settings tab.
B Menu options are shown in bold and italics: Select File > Save as....

® The names of dialogue options (function buttons, checkboxes) are specified in italics:
Select Fixed, if you ...

B Buttons are bold and in italics and shown in brackets: Click [Apply].
B Buttons labelled with graphic icons are described by words.

Example: Qe is a [Zoom] button.
®m References to other pages in the manual are indicated by italics: See page 22, Setup.
® Links to web addresses are underlined: Visit RAYLASE.

B |mportant technical terms are explained in the glossary, see page 83, Glossary.

1.5.1 Version reference
The following table references the manual version of the corresponding software product
version.

Manual version PROCESS DATA ANALYZER version

V1.0 v1.0

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 8
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1.6 Legal Information

Copyright

RAYLASE reserves the right to make changes to the product described in this manual and to
the contents of this manual at any time without notice.

All rights reserved.

Duplication of this manual or extracts from it — in particular by photocopying, scanning or
photographing — and any other form of reproduction is only permitted with the prior written
consent of RAYLASE.

License agreement

The text of the license agreement is delivered as a PDF file together with the software.

Warranty

The rights of the customer in case of material or legal defects of the product are listed in the
General Terms and Conditions of RAYLASE. These can be viewed at: https://www.raylase.de/
en/terms-and-conditions.html.

No implied warranty or guarantee is given as to fitness for a particular purpose. RAYLASE is
not responsible for any damage caused by using the application. Custom assemblies or other
assemblies manufactured by RAYLASE may be subject to different warranty terms. Further
information can be found in the respective manuals.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 9
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1.7

Addresses

Manufacturer
RAYLASE GmbH
Argelsrieder Feld 2+4
D-82234 Wessling

www.raylase.de

Telephone:
Fax:
E-mail:

+49 8153 9999 699
+49 8153 9999 296
info@raylase.de

Customer service

The RAYLASE customer service would be happy to help you at any time if you have any
problems with the software or this manual.

Availability:

Telephone:
E-mail:

Monday to Friday, 9:00 am to 7:00 pm

UTC+1 (April to October: UTC+2)
+49 8153 9999 297
support@raylase.de

© 2024 RAYLASE GmbH
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2 INSTALLATION AND COMMISSIONING RAY LAS E

2.1

INSTALLATION AND
COMMISSIONING

Requirements

To successfully install the PROCESS DATA ANALYZER software on a computer, the following
requirements have to be met:

Supported operating systems

®  Microsoft Windows 10, 64 bit

®  Microsoft Windows 11, 64 bit

NOTE: The Linux operating system is not supported

Minimum hardware requirements

B Microsoft .NET Framework version 4.8 or higher
® 8 GB RAM (16 GB recommended)

B 200 MB of free disk space

Scan controller
® A RAYLASE SP-ICE-3 control card is required for recording data.

A deflection unit, which is controlled by the control card, is required to record actual
position data or status information.

NOTES:
B |nstallation and setup of the control card are described in a separate user manual.

B No control card is required to open data recordings that have already been recorded and
saved.

Correction file

For the inverse field correction, it is necessary that a RAYLASE correction file (FC3) is loaded
onto the control card.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0]

11



2 INSTALLATION AND COMMISSIONING RAY LAS E

2.2 Installation process

Double-click on the ProcessDataAnalyzer.exe to start the installation.

For the installation of all RAYLASE software products (and also the PROCESS DATA ANALYZER
application), the RAYLASE provides the so-called RAYBOARD PRODUCT INSTALLER (RLPI) free
of charge as a central tool on its website.

Using the “Select the targeted software configuration” menu item, select the latest version of
PROCESS DATA ANALYZER.

% RAYBOARD PRODUCT INSTALLER - Version 1.2.0.0
Select the targeted software configuration
NAME DESCRIPTION INSTALLED VERSION  SELECT VERSION CHANGE LOG
@ License Manager Tool for querying, requesting and updating any RAYLASE licenses. 1.49.0 (latest) 1490 (latest) +
@ Multi Point Editor Software for creating/editing fieldpower cormrection files 8.1.0 (latest) - View Change Log
+ @ Process Data Analyzer Software to analyze process signal data received and provided by SP-ICE-3 control board 1.0.0 (latest)y ~ +  View Change Log
E RAYGUIDE Software for advanced laser marking. 1.51.0 - View Change Log
RAYGUIDE Click & Teach  RAYGUIDE add-on for teaching layout positions using camera images (54bit only). 1510 ~ | View Change Log
SP-ICE-3 Log Viewer Tool for visualizing SP-ICE-2 log files 1490 (latest)  ~
g: SP-ICE-3 5W Client SW package containing libraries, tools and documentation_ 3.2.1 (latest) 3.2.1 (latest) - View Change Log
g:- SP300011 SPICE3: SerialNumber SP300011 3.2.0 3.20 | View Change Log

Fig. 2.1: PDA-ABC

Under the installation options, select whether you only want to use the PDA GUI and/or want
to install the PDA SDK:

'ﬁ_; RAYBOARD PRODUCT INSTALLER - Version 1.2.0.0

Select installation options for:

Process Data Analyzer

4 Process Data Analyzer
P Components
+'| Process Data Analyzer GUI Graphical user interface for Process Data Analyzer (64bit only).
Process Data Analyzer SDK Software development kit for Process Data Analyzer (64bit only).

Fig. 2.2: PDA-ABE

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 12



2 INSTALLATION AND COMMISSIONING RAY LAS E

Agree to the license agreement.

'f_;! RAYBOARD PRODUCT IMSTALLER - Version 1.2.0.0

License agreement

Process Data Analyzer

The following software requires you to read and accept its license agreement:
Process Data Analyzer

Show license agreement

Accept license agreement

Fig. 2.3: PDA-ABF

After successful installation, you receive the following information in the RAYBOARD
PRODUCT INSTALLER.

'ﬁ_f‘,’! RAYBOARD PRODUCT IMSTALLER - Version 1.2.0.0

Summary

The RAYBEOARD PRODUCT INSTALLER successfully performed the following actions

NAME VERSION ACTION
@ Process Data Analyzer  1.0.0 Install

Fig. 2.4: PDA-ABG

The direct link to the change log lets you review the latest changes relative to the predecessor
version. The RLPI then downloads the PROCESS DATA ANALYZER installation file and displays
the installation options.

By default, the installation process creates the following folders:
B For the program:
C:\Program Files\RAYLASE\PROCESS DATA ANALYZER\
B To store configuration files, log files, and other resources:
C:\ ProgramData\RAYLASE\PROCESS DATA ANALYZER\
®  User-specific data is stored in this folder:
C:\users\Benutzername\AppData\Loca\RAYLASE\PROCESS DATA ANALYZER\
The software environment for the license management is also installed.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 13



2 INSTALLATION AND COMMISSIONING RAY LAS E

The installation process creates an icon on the computer’s desktop for directly launching the
PROCESS DATA ANALYZER application:

@f\

Process Data Analyzer|

Fig. 2.5: PDA-ABB

Starting the software
For example, use the PROCESS DATA ANALYZER desktop icon to start the software.

When the PROCESS DATA ANALYZER application software is started, the first license check
also takes place. If no valid license is found, PROCESS DATA ANALYZER starts in demo mode.

NOTE: After starting the software for the first time, a pop-up dialogue with explanations of
frequently used mouse function combinations is automatically displayed.

The pop-up dialogue is also available at any time at Help > Show Mouse Controls.

If necessary, use the checkbox if you do not want the dialogue to be displayed every time you
start the application.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 14
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3.1

3.1.1

LICENSES AND UPDATES

Licenses

Software functional gradations
The PROCESS DATA ANALYZER can be operated in the following variants.

Demo variant
If no valid license is found, PDA starts in demo mode.
It allows the selected signals to be recorded and the recordings to be saved.

However, the demo version does not allow zooming in and therefore no detailed analyses.
This version is primarily intended for recording data in support cases.

Basic variant
A license is required for this version.

It allows signals to be recorded and saved. All viewing options and zoom functions are
available.

This license is also required to use the SDK interface.

Licensable additional options
The following additional options are also available:
®m Sensor interface version

A license is required for this version.

Compared to the basic version, this license option also allows the recording of signals that

come via the ADC Adapter board. These are typically signals from process monitoring
sensors.

= Multi-Card option
This additional option allows simultaneous data recording of up to 12 control cards.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0]
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3 LICENSES AND UPDATES m .

3.1.2 Type of provision

The license can be distributed in two ways.

USB dongle (hardware license key)
A USB dongle is connected to a USB port on the computer on which the software is running.

This variant allows you to install the software on more than one computer and use the same
dongle on each of them in turn. When the software is installed or started with the dongle
attached, the license is found and activated automatically.

NOTE: The dongles are only labelled with RAYLASE as a dongle can contain licenses for
various RAYLASE software products.

Activation license file (software license key)
A software license key is only valid for a specific computer.
To use a software key, a "fingerprint" of the designated computer has to be generated.

B |n the menu, select Help > License > Generate License Request, and send the generated file
to RAYLASE (license@raylase.de).

m RAYLASE then provides you with an activation file which you can import via Help > License
> Activate License.

NOTE: A software license key can only be used on the PC where the license request file was
generated. It is not possible to move or exchange the license file later.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 16



3 LICENSES AND UPDATES m .

3.1.3 Displaying current license / version

To view the license and version information for the installed software, in the menu select

HelpAbout > .

Example:

PROCESS DATA ANALYZER

Version 0.73.0.835
Copyright D 2023 RAYLASE GmbH.
Build date 02.03.2024

SP-ICE-2 ClientLib
Version 3.2.0.1668

@ License

License product Feature update runtime
ProcessDatafAnalyzer 01.01.2020 - 31.12.2030
ProcessDatafnalyzerSensorinterface 01.01.2020 - 31.12.2030

ProcessDataAnalyzerMultiCard 01.12.2023 - 31.12.2020

RAY TARD

Senal number 3-4378029

OK

Fig. 3.1: PDA-AAX

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0]
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3.2

3.2.1

3.2.2

Updates

Feature updates
Each license comes with a predefined runtime for feature updates at the time of purchase. As
a rule, this is two years.

After expiration of the runtime, it may happen that new features cannot be used
automatically by installing updates. Then it is up to you to purchase a runtime extension.

The update of the feature update runtime is done via license file import, see page 16, Type of
provision.

NOTE: RAYLASE reserves the right to decide which new features can only be used with the
current feature update runtime.

The import of new releases / updates by means of the RAYBOARD PRODUCT INSTALLER is
possible independently of this at any time.

Troubleshooting

The import of new software versions for the purpose of troubleshooting is possible at any
time and does not require a license update.

Also use the RAYBOARD PRODUCT INSTALLER for this purpose.

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 18
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4.7

INTRODUCTION TO THE USER
INTERFACE

Overview
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Fig. 4.1: PDA-AAA

No.

Element Explanation See ...

Menu bar The main menu provides access to all standard page 20,
functions. Menu bar

Function bar The funtion bar contains buttons / functional elements |page 23,

® to connect to the control card and Function bar

m for frequently used functions

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 19
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No. | Element Explanation See ...
3 | Panel: XY Plots Diagram(s) for displaying the signals in the XY page 25,
coordinate system. Panels
4 |Panel: Time Plot Diagrams for visualizing signal progression over time.
5 |Panel: Acquired Signals & |Display of all currently configured signals and your
Cursors measured values.
6 |Info bar Left: Display of important settings (permanent)

Right: Display of status messages (dynamic)

Tab. 4.1: PDA-001

4.2 Menu bar

4.2.1 “File” menu
Menu item Explanation
Open A recording that has already been saved in PDA format.
NOTE: A connection to a control card is not required for this.
Save Save the current recording in PDA format.
Export Export the data of the current recording in text-based formats (e.g. *.txt or *.csv).

For more details, see page 75, Saving / Loading data recordings.

Exit Close the application.
Tab. 4.2: PDA-002

4.2.2 “View"” menu

Menu item Explanation

XY Plots Display / Do not display XY Plots panel.

Time Plot Display / Do not display panel Time Plot.

Acquired Signals & |Display / Do not display panel Acquired Signals & Cursors.

Cursors

Reset Layout Reset the arrangement of the panels to the default layout of the user interface.

Tab. 4.3: PDA-003

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 20
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RAYLASE

4.2.3

"“Settings” menu

Menu item

Explanation

Preferences

Opens the dialogue for defining default settings for the display of the diagrams.
For more details, see page 66, Preferences.

NOTE: These settings can also be changed after signal recording. They are
immediately applied to the existing diagrams.

Configurations

Opens the signal configuration dialogue.
For more details, see page 28, Configuration of the signal parameters.

4.2.4

Tab. 4.4: PDA-004

“Help” menu

Menu item Explanation
Show Mouse Opens a pop-up dialogue window with an overview of the most important mouse
Controls functions for the XY Plots and Time Plot panels.
Controls
XY Plot Hints Time Plot Hints

Left Drag Pan Left Drag Pan

<Shift=/<Ctrl>+Drag Pan X/Y Only <Shift=/«<Ctrl=+Drag Pan Time/Signal Axis Only

Middle Drag Zoom Box Middle Drag Zoom Box

Right Click Context Menu Right Click Context Menu

Scroll Zoom Scroll Zoom Time Axis

<Shift>/<Ctrl> +Scroll Zoom X/Y Only < Ctri=+5Scroll Zoom Signal Axis Under Mouse

X/Y Axis Scale X/Y Axis Scale

Left Drag Pan Left Drag Pan

Scroll Zoom Scroll Zoom

Left Click Confirm Left Click Confirm

Double Click Remove Double Click Remove

Left Drag Head/Tail Adjust Head/Tail Left Drag Head/Tail Adjust Head/Tail

Left Click Toggle Highlighting Double Click Reset Position to Trigger On/Off

Left Drag Move
F4 Hide all value labels
For additional details on the mouse functions, Zoom and Pan (shifting section), see
page 54, Navigation in the diagrams.
Debug ® Save Debug Info:
Saves all data required for error analysis in a ZIP file.

© 2024 RAYLASE GmbH
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4 INTRODUCTION TO THE USER INTERFACE R AY LAS E

Menu item Explanation

NOTE: In the event of an error, send the file to RAYLASE customer service.

B Open Log File Location:
Opens the storage locations of the PDA log files.

License B Generate License Request:
Generates a license request file (*.WibuCmRaC). The file is required from RAYLASE
to issue your activation license. For more details, see page 16, Type of provision.

B Activate License:
Loads an existing license activation file or a file for a license upgrade.
(*.WibuCmRaU)

About Opens an overview of the installed software version and your purchased license
products.

Tab. 4.5: PDA-005

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 22
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4.3

Function bar

Card: |

BEYE

Fig. 4.2: PDA-AAB

Element Explanation
[ee | -/ Name (serial number) and IP address of the scan controller. Identify the SP-ICE-3
Card: control card by its serial number and select it.

NOTES:

B |n most cases, each scan controller appears once with its IP4 and once with its IP6

address.

Which IP address family is selected for the scan controller does not affect the
connection speed to the scan controller.

[Auto-reconnect
at startup]

O\ Click on the [Discover] button to search for available control cards on the network.
[Discover]
Q Click on the [Connect] or [Disconnect] button to connect with or disconnect from
the control card.
[Connect] An active connection to the control card can be identified by the fact that
® the serial number of the active control card is also displayed in the header and
Q‘ B the button for configuration becomes active.
[Disconnect]
(o\’ Toggle button to define if the control card should be connected automatically when
Q PDA starts.

The [Auto-reconnect at startup] button is enabled by default.

If you disconnect from the control card and do not want it to reconnect automatically
the next time you start the program, you must disable the [Auto-reconnect at
startup] button.

o

[Configure signal
parameters]

[Configure signal parameters] is used to open the dialogue window for
configuring the signals, recording trigger, time behaviour.

See page 28, Configuration of the signal parameters.
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[Open list of

Element Explanation
@ Use the [Start acquisition] or [Stop acquisition] button to start or stop signal
recording.
[Start acquisition] Whether the S|gn§Is are recgrded and displayed immediately after starting also
depends on the trigger settings.
@ NOTE: Depending on the amount of data and the default settings, it may take some
time for all signals to be displayed when signal recording is stopped.
[Stop acquisition]
@ Enable the [Auto-stop acquisition] toggle switch to stop signal recording after a
im predefined time (default = 60 seconds).
[Auto-stop Use the [+] / [-] buttons to extend or shorten the timer setting in 10-second intervals.
acquisition]
P Use the [Open list of triggered segments] button to display a list of all recorded
= segments.

For details, see the page 43, Triggering, multi-segment trigger option.

[Open the list of
position related

triggered

segments]
=|| Use the [Open the list of position related timestamps] button to open the list of
[+ all points in time associated with the position selected in the XY diagram.

For more details, see section page 64, Determining points in time for a trajectory
position.

[Lock signal auto-
resize]

timestamps]
Use the [Zoom XY plot to field size] button to fit the entire scan field in the XY
diagram.
[Zoom XY plot to
field size]
a Enable the segment [Lock signal auto-resize] toggle button if you always want to
And have the same time segment in the time diagram by default.

If not active, the complete recorded signal curve is always fitted into the time
diagram.

C

[Toggle light or
dark background]

Enable the [Toggle light or dark background] toggle button to change the
background color of the user interface to black.

If not enabled, the background is white by default.

Tab. 4.6: PDA-006
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4.4 Panels

The user interface basically consists of the three panels XY Plots, Time Plot and Acquired
Signals & Cursors .

The panels can be freely arranged in relation to each other using the panel manager.

Trigger Info: All data is recorded regardless of trigger.

+'| Show commanded signals |+'| Show measured signals

Signal Unit XY coloring
e [5] -
' | Field Commanded X [mm] ;
+" | [Field Commanded ¥ [mm] _

Fig. 4.3: PDA-AAC
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Example:

Right-click on the tab (underlined in red) to display three options in the context menu:

The panel can be freely positioned.

As soon as you move the detached panel, the panel manager
appears, which can be used to dock the panel at a different
position.

The panel is docked.

B Floating:
® Dockable:

B Tabbed document:

The XY diagrams are stacked with tabs by default, but can also be arranged next to each
other using the panel manager if required.

To do so, grab the diagram by the tab with the mouse and fix it next to the other XY diagram
using the panel manager.

Gate b4 Laszer Power 16-bit *
40
40
30
30 o
f \
20 — /
20 F \
E E S 't
E E < =
= =
Z 10+ 5 101 ™ =
7 7 T
£ T
=
——
g
04 -10 - f <
=20 —
-20
T T T T T T T T T T T T T
-40 -30 -20 -10 0 10 50 -0 -30 -20 -10 0 10
XY i3 Field X [mm] XY i3 Field X [mm]

Fig. 4.4: PDA-AAD

In the View menu, you can enable or disable the display of the three panels and reset the
layout of the user view.

See page 20, “View” menu.
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5 FIRST STEPS

5.1 Connecting control card

In order to be able to record data or signals, the PDA application must be connected to a
control card.

NOTE: In principle, a PDA application can only have one connection to a card.

If you want to record signals from several control cards at the same time, you have to start
the PDA application several times. Connect each instance to a different control card.

NOTE: Please note that a special license product (PDA Multicard) is required.
... Procedure The following steps are necessary to establish a connection with a control card:

1. In the function bar, click on [Discover] to find the available control cards.
O\ 2. ldentify the desired control card in the results list and select it.

3. Click on [Connect] to establish the connection to the selected control card.

active (the button display changes from grey to black).
— The serial number of the control card is displayed in the center of the menu bar.

4. Optional: Click on the [Auto-reconnect at startup] toggle switch to automatically
ﬁ’\cg establish the connection to the selected control card when restarting the PDA application

Q — Assoon as the connection is established, additional buttons in the function bar become

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0]
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5.2

5.2.1

2

Preparing signal recording

Before you start signal recording, certain settings should be made depending on the
application.

These basically include

m Selecting the signals or data to be recorded

®m Defining trigger events to limit or control the recording range in terms of time

®  And ensure that the control card (SP-ICE-3) is correctly configured, in particular

Configuration of the signal parameters

That the appropriate correction file has been loaded onto the control card

That the appropriate deflection unit is connected

That the correct communication protocol is set between the control card and deflection

unit and
That the tracking error values of the deflection unit are set correctly

The signal parameters are configured using the Settings > Configurations menu.

Alternatives:

®m Click on the [Configure signal parameters] button in the function bar

® Use the [F3] quick access button.

Button Explanation

B Saves the current configuration.

~ Loads a previously saved configuration.

o Reloads the configuration settings from the configuration file.

&) Reloads the following parameters of the SP-ICE-3 control card in the PDA
application:
® |nverse field transformation
B |nverse field correction
®m Tracking error
® Field size
B Simulation encoder speed

Resets the configuration back to the default values.
CAUTION:
All virtual signal configurations are also deleted.

The trigger setting is set to “None” mode.

Tab. 5.1: PDA-008
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5.2.2 Signals
The Signals

tab is used to select the required signals.

... call up Settings > Configurations > Signals.

Signals  Virtual

Configurations | SP300693

signals Triggering Timing

Available signals

v  All signals
> ADC
?»  Feedback

»  Field Position

Configured signals XY plot domain
| Field Commanded X XY coordinates (® Field O Part
+ | Field Commanded Y Field domain coordinates without MOTF compensation.

Field Commanded Z
/M Field Measured X

/M Field Measured ¥

>  Raw Trace Buffer Event /N Field Measured Z

| Gate
+' | Laser Power 16-bit

Label

oK | | Cancel

Fig. 5.1: PDA-AAE

The tab Signals is grouped into three columns:

Column

For explanations, see ...

Available signals

page 30, Available signals

Configured signals

page 39, Configured signals

XY plot domain

page 40, XY plot domain

Tab. 5.2: PDA-012

NOTE: With the initial configuration, the most frequently used signals are already created

and you can

start right away. Depending on the application, you can select additional signals.
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5.2.2.1 Available signals
You will find all available signals in groups in the Available signals column.
NOTE: Some signals cannot be configured depending on the current settings.
Symbol Explanation Cause

Although this signal can be

data.

configured, it will not provide any equipped with the corresponding optical

The connected deflection unit is not

axis.

This signal cannot be configured. The currently set communication protocol

(including correction file) does not
support data transmission for this signal.

Tab. 5.3: PDA-009

5.2.2.1.1 ADC
In the signal group, ADC select the configuration of the control card and ADC Adapter.
Then select your signal
B On which port of the SP-ICE-3 control card the ADC Adapter board is connected (port A or
B) and
B On which of the four inputs of the ADC Adapter board the analog signal is fed (0 ... 3)
Signal: ADC Port Port index differential
(SP-ICE-3 control card) analog input
(ADC Adapter board)
ADC > ADCA:0 Port A = X903 0
> ADC A:1 1
> ADC A:2 2
> ADCA:3 3
> ADC B:0 Port B = X901 0
> ADCB:1 1
> ADCB:2 2
> ADCB:3 3
Tab. 5.4: PDA-010
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NOTE: Recording the analog signals via the ADC Adapter requires an appropriate license, see
page 15, Software functional gradations.

For information on the use of the ADC Adapter boards, see page 78, Notes on using the ADC
adapter board.

5.2.2.1.2 Feedback
Select the Feedback signal (status information) of the deflection unit that you want to
record.
The Feedback signals can be selected for all six conceivable axes.
Signal: Feedback In each case for the
axes...
Feedback > Current Position > X
> Current Velocity >Y

> Galvo Temperature

> Output Current ZoomZ

— Auxiliary
> Position Error

> Relative Output Control

> RMS Current

X (2nd Head)
Y (2nd Head)
Z (2nd Head)

>
>
>
> SensorZ
>
>
>

> Servo Board Temperature

> Target Position

Tab. 5.5: PDA-011

NOTES:

® Please note that the availability of the Feedback signals depends on the model of the
RAYLASE deflection unit and the FPGA version of the DICON eletronic.

If you have any questions, please contact RAYLASE support.
® Please note that only one of the available feedback signals can be queried per optical axis.

m |f two deflection units are controlled by a single control card in master-slave mode, only
Feedback signals from a maximum of three axes are available per deflection unit.

B A detailed description of the Feedback signals (status information) can be found in the
Enhanced Protocol Manual.

CAUTION: If you have connected deflection units of other manufacturers to the SP-ICE-3
control card, RAYLASE itself cannot guarantee the analogy of the status information when
using the SL2-100 protocol.
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5.2.2.1.3

Field Position

The position data indicate the axis positions in the so-called field domain.

The position data are calculated from the position data of the scanner domain using an
inverse field correction (including inverse field transformation). This applies to both the
Commanded Positions and the Measured Positions. This makes it possible to display the
position data in the same coordinate system in which you define your scan geometry.

Signal: Field Position

Field position

Field Position

> Commanded Positions

>

Field Commanded X

>

Field Commanded Y

>

Field Commanded Z

>

Field Commanded M (magnification)

> Measured Positions

Field Measured X

Field Measured Y

Field Measured Z

Field Measured M

NOTES:

Tab. 5.6: PDA-013

® |f you want to record position data in the scanner domain, for the Feedback signals, select

— Target Position or the Tx channel for the TARGET positions
— Current Position for the ACTUAL positions

B |n dual head mode (master-slave control of two 2-axis deflection units), the positions in the
field domain can only be generated for the first deflection unit because no inverse field
correction can be calculated for the second deflection unit.
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5.2.2.14 Raw Trace Buffer Event

Unprocessed trace buffer events.

Signal: Raw Trace Buffer Event

For explanations, see ...

Raw Trace Buffer Event

> DAC page 33, DAC

> Head page 34, Head
> 10 Pin page 36, 10 Pin
> 10 Port page 37, 10 Port
> Label page 37, Label
> Laser page 38, Laser
> SPI page 38, SPI

5.2.2.1.4.1 DAC

Tab. 5.7: PDA-014

Analog output signals, e.g. for controlling the laser power.

Signal:

Raw Trace Buffer Event > DAC

Explanation

DAC

> DacO0

Primary laser power

> Dac1

For example, secondary laser power or simmer
current

Tab. 5.8: PDA-015

© 2024 RAYLASE GmbH

MN_PROCESS DATA ANALYZER [V1.0]

33




—

5 FIRST STEPS RAYLASE .

5.2.2.1.4.2 Head

Deflection units and channels

The signals are displayed in 20-bit decimal format for the forward and return channels.

Signal:

Raw Trace Buffer Event > Head

Head

HeadORxX
HeadORxY
HeadORxZ
Head0TxX
Head0TxY
Head0TxZ

> Head 0

V V. V VvV VvV V

Head1RxX
Head1RxY
Head1RxZ
Head1TxX
Head1TxY
Head1TxZ

> Head 1

V V. V VvV VvV VvV

Tx:

Rx:

Tab. 5.9: PDA-017

® Channel for sent data

B Generic channel for all commands sent from the control card to the deflection
unit (e.g. enhanced commands, target positions in the scanner domain)

® Channel for received data

B \Which data is received here must be set in advance using an enhanced
command.

NOTE: The use of the Rx channel is not recommended. Instead, select the
corresponding feedback signal right away. This ensures that the desired data is sent
on the feedback channel.
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Overview of axis declaration:

Field domain Scanner domain Assignment
X Head0-X X-mirror — deflection unit 1
y Head0-Y Y-mirror — deflection unit 1
Z Head0-Z Z-axis (laser focus)
M (magnification) Head1-X Zoom axis (AM-MODULE) or
X-mirror — deflection unit 2
Auxiliary Head1-Y RAYDIME METER or
Y mirror — deflection unit 2
SensorZ Head1-Z RAYSPECTOR

Tab. 5.10: PDA-035

Relationship between Tx and the feedback signal Target Position

The Target Position is the position that is output in the deflection unit to the galvanometer
scanners by the electronics.

If the commanded position change (i.e. scan speed) of Tx is too high, the so-called Slew Rate
Limiter intervenes by reducing the speed. The Target Position is then less steep than Tx (see
example).

Example: 160000

== —
) jmm \ \ Rx = Target position

= 0 =
B 20000 \ Tx = commanded position
T from control card

-120000
-140000
-160000

T T T T T T T
1,4425 1,443 1,4435 1,444 14445 1,445 1,4455
Millisecond [ms]

Fig. 5.2: PDA-ABG
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52.2.14.3 10 Pin
Specific input and output pins for signals can be selected here (mostly used for process
control).
Signal: Explanation
Raw Trace Buffer Event > 10 Pin
IO Pin > Abort Mark Input for signal for list termination.
> Port LaserIn0 Generic input, depending on the configuration it can
be used for laser alarm.
> Port Laser In 1 Generic input, depending on the configuration it can
be used for a MOTF component sensor or as
synchronisation with special lasers.
> Port Laser Out 0 Generic output, depending on the configuration, the
“Arm Laser” signal can be output here.
> Port Laser Out 1 Generic output, depending on the configuration, the
signal for the pilot laser can be output here.
> Port Laser Out 2 Generic output, depending on the configuration, the
“Mark Engine Busy” signal can be output here.
> Start Mark Input for signal for list start.

Tab. 5.11: PDA-018
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5.2.2.14.4 10 Port

Specific input and output connections of signals can be selected here (mostly used for process
control)

The value is then displayed as a decimal value in the time diagram.

Signal: Explanation
Raw Trace Buffer Event > 10 Port

10 Port > Port A Digital, generic |0 interface port A with 16-bit input.
> PortB Digital, generic 10 interface port B with 16-bit input.
> Port C Digital, generic 10 interface port C with 16-bit input.
> Port D Low Digital, reserved interface port D; the lower first 16
bits (of 24 bits).

> Port D High Digital, reserved 10 interface port E; the upper
remaining 8 bits (of 24 bits).

> Port E Low Digital, reserved interface port D; the lower first 16
bits (of 24 bits).

> Port E High Digital, reserved 10 interface port E; the upper

remaining 8 bits (of 24 bits).

> Port Laser In The 2-bit 10 input of the laser control, port X907 of
the control card.

> Port Laser Out The 3-bit 10 output of the laser control, port X907 of
the control card.

5.2.2.14.5 Label
The values of the so-called trace labels contained in the command list are displayed here.
The trace labels must be set proactively by the application software.
Typical trace labels of the RAYGUIDE application software are:
10 = Start of a list
11 = End of a list
12 = New slice position for deep engraving
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5.2.2.1.4.6 Laser

You can select dedicated output signals that are used for laser control here.

Signal:

Raw Trace Buffer Event > Laser

Explanation

Laser

> FPS

First Pulse Suppression

> Laser Power 16-bit

Laser power specification as 16-bit value
(Standard)

> Laser Power 1-bit

Laser power specification as 1-bit value

> Laser Power 2-bit

Laser power specification as 2-bit value

> Laser Power 4-bit

Laser power specification as 4-bit value

> Laser Power 8-bit

Laser power specification as 8-bit value

> Laser Triggered

Signal for laser synchronisation (1 bit)

> Lm

Laser Modulation
(Pulse repetition rate or laser frequency)

5.2.2.1.4.7 SPI

Serial Peripheral Interface

Here you can select the data received via the SPI interface.

Signal:

Raw Trace Buffer Event > SPI

Explanation

SPI

> Spi 0 Rx

> Spi 1 Rx

> Spi 2 Rx

> Spi 3 Rx

Data can be recorded via SPI Rx, which an SPI slave
device, e.g. a laser adapter board, reports back.

CAUTION: The selection of these signals in PDA
requires correct configuration of the respective SPI

module beforehand (either via API commands of the

control card or with the SP-ICE-3 config tool).

For additional details, see SP-ICE-3 Manual,
section 10.3.1.
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5.2.2.2

Configured signals

The Configured signals displays a list of the signals you have selected from the Available

signals column.

®  Only the signals selected using the checkbox are recorded.

B The signal order displayed in the Configured signals column also defines the order in the

Time Plot panel and the Acquired Signals & Cursors panel.

You can use drag & drop to change the sequence as required.

®m (Clicking on the [Remove signal] button removes the signal from the Configured

signals column.

(The button appears as soon as you move the mouse over the signal entry)

® Some signals are not available in the required unit. For these signals, fields for signal

conversion are displayed below the list.
For some signals, the values for scaling are already predefined.

You can also specify the physical unit of the signal here as an option in order to declare

the diagram axis accordingly.

+ Target Position X
v Head DR

o Head 0T

Signal conversion (Target Position X)

Scale =0 (535

Offset +0

Unit

Fig. 5.3: PDA-ABD
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5.2.2.3 XY plot domain

For the analysis of laser processes that are run in "Marking-on-the-fly" (MOTF) mode, it is
often interesting to check how the marking would appear on the moving component.

That is why the PDA has the option of displaying the position data edited by the simulated
belt movement speed.

To do so, select Part. The corresponding signals for the positions, e.g. Field Commanded X and
Field Commanded Y are automatically renamed in Part Commanded X and Part Commanded
Y.

Fiela Y T
Bart ¥ (mm]

E]
.

9563 5151 [mm]

g
L

T 12 T T r - T T T T T T {(D—
, , , E 5 o 3 1 2 2 » 2 o M 0 50 0 250 20 350 a
e Field X (mm) wia Part X )

Fig. 5.4: PDA-AAY

1 Static in the field 2 With belt movement (here you can see the
contour strung together continuously)

CAUTION: This option only works with the simulation encoder of the SP-ICE-3 control card.
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5.2.3 Virtual Signals
The PDA offers the option of configuring so-called virtual signals in addition to the basic
signals.
The virtual signals are always calculated mathematically from existing basic signals.
The scan speed is a common example of this. The scan speed is derived from the local change
in position over time.
However, it is also possible to duplicate a basic signal. For instance, temperature values can be
displayed once as a regular “heat map” and additionally as a “defect map”.
The virtual signals are configured via the Settings > Configurations > Virtual Signals
menu:
Signals  Virtual Signals  Triggering  Timing
Calculation Input Signals Signal Label | Share Axis of | Scale | Offset | Unit
X Field Commanded X ~
Velocity 2D * |+ Velocity - mz
¥ Field CommandedY ~
Fig. 5.5: PDA-AAY
Column Value / Explanation
Calculation Drop-down list
Select the calculation for the virtual signal here.
Use the checkbox to select whether the configured signal should be actively
used for signal recording.
Velocity2D Speed in a layer (derivation of the position change over
time)
Velocity3D Speed in 3-dimensional space
Substraction Difference between input signal 1 and input signal 2
Addition Sum of input signal 1 and input signal 2
Multiplication Product of input signal 1 and input signal 2
Division Divider of input signal 1 and input signal 2
Derivation Derivation from the selected input signal after time
Copy A copy of the selected input signal (useful if two different
XY diagrams of the same signal are required)
NOTE: A copy signal can no longer be used as a base signal
for a virtual signal.
Input Signals Drop-down list
All signals that were previously configured and enabled as signals to be
recorded on the “Signals” tab are available as input signals. (See section 5.2.1.2)
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Column

Value / Explanation

Signal Label

Input field
Enter a useful name for the signal here.

Share Axis of (optional)

Drop-down list

Select a signal with which this virtual signal shares the time diagram. This may
make it easier to compare two signals.

Sharing can be enabled/disabled using the checkbox.

Scale (optional)

Scaling the signal

Offset (optional)

Value offset of the signal

Unit (optional)

Physical unit of the signal

[Add virtual signal]

Adds a new row for configuration of another virtual signal

[Remove virtual
signal]

Deletes the corresponding row or virtual signal

Tab. 5.12: PDA-022
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5.2.4 Triggering

The trigger settings determine when the signal recording starts and stops.

button.

acquisition] button.

Regardless of the trigger setting, recording must be started with the [Start acquisition]

Recording should also be disabled independently of the trigger settings via the [Stop

Configurations | SP300693

Signals  Virtual signals Triggering Timing
Trigger mode O Mone O Single-shot O Continuous  ® Multi-segment
All triggered segments are recorded.
Trigger ch Always =
rigger on immediately upon the first received event,
Trigger off None =
rigger on immediately upon the first received event.
Pre-trigger 0s - =| Extend recording before trigger or
Post-trigger 0s - =| Extend recording after trigger off
Stop after trigger off 0s =+ =| Stop acquisition after the specified time unless triggered on agair
Continuous time If selected, multi-trigger will keep track of the segment time continuously.

Fig. 5.6: PDA-AAG
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In principle, there are four modes to choose from.

Tab
Triggering

Explanation

Trigger mode

None

In this mode, data recording is not started / stopped
by trigger events, but only with the [Start
acquisition] or [Stop acquisition] buttons.

e e

Single Shot

In "Single Shot" mode, only the time segment that
starts with the "Trigger-On" event and ends with the
"Trigger-Off" event is displayed.

See table below for additional settings for this
trigger mode.

Continuous

In "Continuous" mode, all triggered time segments
are recorded live, but only the data from the last
triggered time segment is retained and displayed.

See table below for additional settings for this
trigger mode.

Multi-Segment

In "Multi-Segment" mode, all triggered time
segments are not only recorded but also saved.

After recording is stopped, the last time segment is
displayed. The [Open list of triggered segments]
button is used to individually select all segments for
display.

-

=

See table below for additional settings for this
trigger mode.

Tab. 5.13: PDA-023
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The following settings can be made depending on the trigger mode.

Trigger setting Explanation

Trigger on Select an event with which the recording of a time segment begins.
The choices are:

® Always

B Gateon

®m Trace Label

Trigger off Select an event with which the recording of a time segment ends.
The choices are:

® None

B Gate off

® Trace Label

B Timeout

Pre-Trigger Select whether a certain time span before the trigger event that starts a period
of time to be recorded should also be saved and displayed with the recording.

Enter the desired time span.

Post-Trigger Select whether a certain time span after the trigger event that ends a period of
time to be recorded should also be saved and displayed with the recording.

Enter the desired time span.

Stop after trigger off Select whether recording after the Trigger off event should be disabled if a new
Trigger on event does not occur within a certain time span.

Continuous time Select whether in Multi-Segment trigger mode each time segment starts with
consecutive time per time segment or whether each time segment starts at t=0.

Tab. 5.14: PDA-036
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5.2.5 Timing

On the Timing tab, time values can be viewed, which synchronise the temporal display of the
signals.

These settings ensure, for instance, that the actual position data is offset in relation to the
target position data of the deflection unit so that they are synchronised in the temporal
display.

By default, the following signals are shifted or time-offset by the following parameters:

1. For positions in the field domain, the measured position is shifted so that it overlaps in
time with the commanded position.

2. For raw signals (Tx vs. Rx), a time offset by the amount of the signal propagation time
(control card - deflection unit — control card) can usually be observed. This offset is not
automatically equalised.

If there is a need to change the standard time behavior, this can only be done by defining the
custom delay.

CAUTION: Changing these values without instruction from RAYLASE is generally not
recommended.
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6.1

RECORDING DATA

Activating / Deactivating signal recording

To record data, signal recording must be enabled in order to react to trigger events if
necessary. This is done using the [Start acquisition] or [Stop acquisition] buttons in the
function bar.

Activation can take place before but also during list execution on the SP-ICE-3 control card.

Recording is stopped at the latest when the timer expires (see function bar) to prevent the
recording of too much data from flooding the RAM of the computer.

You can view the data display in the time diagram and XY diagram live. However, in the case
of very long recordings with correspondingly large amounts of data, live rendering of data
may not be possible. In this case, some time will pass after recording stops until all data has
been rendered for display.

NOTE: The XY diagram is automatically fitted to the scan field after signal recording is
enabled and any previous trajectories are removed.

The time diagram starts with t=0, at the point in time of the start trigger event.
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6.2 Time plot: Temporal display of the signals

All signals configured according to page 39, Configured signals and all virtual signals are
always displayed over time. All time diagrams have the same X-axis (time), where t=0 is the
trigger time. The unit of the time axis (seconds vs. milliseconds vs. microseconds) can be
defined in the Preferences (see page 66, Preferences).

After signal recording ends, the X-axis is automatically scaled by default so that the complete
time span is displayed, taking into account the trigger events.

Alternatively, you can switch off automatic scaling using the [Lock signal auto-resize]
— toggle button. The axis range then remains as it was before signal recording was started.

The Y-axis of the signals depends on the signal.

Most signals transmit 20-bit data, which is displayed in the diagram as a decimal value. The
scaling of the Y-axis of these signals can be adjusted. For details, see page 39, Configured
signals.

Some signals are pure Boolean signals (e.g. gate signal). As only the True or False signal status
is displayed here, the Y-axis cannot be scaled.
The data of all signals are displayed below each other in the Time Plot panel. This means that

not only is the X-axis common to all signals, but the cursor also runs vertically through all
signal curves.

SPECIAL FEATURE of the diagram sections for the field position of an axis:

The signals for commanded and measured position data of optical axes in the so-called field
domain each share a diagram section or the Y-axis so that they can be directly compared to
each other. They are displayed in different colors to distinguish them.

As position data can also be sent / received on the Tx and Rx channels of an axis, these two
signals also share a diagram section.

NOTES:

B The height dimension of the individual sections of the time diagram is uniform. It can be
defined in the Preferences (in pixels). Diagrams of Boolean signals are an exception.

m |f the vertical screen area in the GUI is not sufficient to display all diagram sections one
below the other, a scroll bar appears on the right-hand edge.

®m  Using the checkboxes in the Acquired Signals & Cursors panel (TP column), you can hide
or display individual diagram sections.
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® |f you want to hide all time diagrams at once, use the View menu option. Disable Time
Plot here.
®m The [F4] function button can be used to hide the value labels along the cursors if required.

Example: Time plot Time plot
A B A B
250 2,018,925 [r2,123.988 [ms] 250 2,018.925 [r2,123.988 [ms]
200 200 Plotting of acquired signals as time series.
Qverlapping labels
150 PPIng 150
136,021 1 i . > %
€ ——— “ 24 El:—lg [mm] E x
E. 100 13.666 [mriy E 100
= e
= 1=}
@ 50 T 50
[T L
0 [F4] 0
B >
100 100
100 100
a0 a0
60 66.012 [mm 60
40 R 40
39.092 fmm}4 [mm]
E o E o
= >
o -20 o -20
= a0 2 a0
-60 -60
=30 =30

Fig. 6.1: PDA-ABK
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Right-click the mouse in the time diagram area to open the context menu. You will find
additional functions there:

Measure
Clear measurements

o Auto-tracking XY plot
Center XY plot here
Clear XY center marker(s)
Fit signal axes
Fit all
Save as image

Fig. 6.2: PDA-ABH

Element Explanation

Measure Starts the measurement function. See page 61, Distance measurement tool.
Clear measurements Deletes all currently displayed measurement vectors including measured values.
Auto-tracking XY plot If enabled, the viewport of the XY diagram is automatically fitted to the

recorded trajectory after recording is complete.

Center XY plot here Centers the viewport of the XY diagram around the XY coordinate that belongs
to the current point in time of the T cursor, regardless of the zoom level in the
XY diagram. See page 64, Centering XY diagram around a point in time.

Clear XY center marker(s) | Deletes all vertical auxiliary lines for timestamps that mark an XY position. See
page 64, Determining points in time for a trajectory position.

Fit signal axis Scales and shifts the Y-axes of all diagram sections so that all data graphs of the
currently displayed time span are visible.
Fit all Scales and shifts the Y-axes of all diagram sections as well as the time axis so
that the complete data graphs are visible.
Save as image Saves the complete time diagram with the currently displayed time span as a
* :
.png file.
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6.3

XY plot: Locally resolved signal display

The XY diagram is basically used to display the value progression of signals in the scan field
using color.

If you only want to view the trajectory of the deflection unit in the scan field, it is enough to
display a “simple” signal (such as the laser gate signal) in the XY diagram.

In principle, however, any signal (including the virtual signals) that have been configured
according to page 39, Configured signals can be displayed in an XY diagram with local
resolution along the trajectory. It is always possible to display the trajectory based on the
commanded positions. As soon as a RAYLASE deflection unit is connected and switched on,
the trajectory can also or alternatively be displayed based on the measured positions.

IMPORTANT: The location or position refers to the coordinate system of the scan field. This is
achieved by the PDA application calculating the position in the scanner domain back into the
field domain via an inverse field correction and inverse field transformation.

NOTES:

® Basically, the display of signals in the XY diagram only makes sense for signals that change
their value depending on their position. This change is then represented in the XY diagram
by a change in color. This type of representation is also sometimes referred to as a “heat
map”. For more details on the setting options for color coding of the signals, see page 68,
Color settings in the XY diagram.

B The data in the XY diagram are rendered as vectors by default. This enables very clear
display and good resolution even at high zoom levels.

m  Alternatively, the data can also be rendered as pixel graphics. This variant is particularly
suitable if a large amount of data is recorded, for instance, if laser processes that contain
fills or pixel graphics are to be analyzed. For details, see page 66, Preferences.

m Basically, multiple XY diagrams are stacked one behind the other in tabs.

® |f you move the mouse cursor very close to a trajectory, it will be displayed “thicker” (until
you move the mouse cursor away).

B You can also use the panel manager to arrange two or more XY diagrams next to each
other to make it easier to compare them.
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®m Use the checkboxes in the Acquired Signals & Cursors panel (XY column) to display the
XY diagram for a signal. The Gate and Laser Power 16-bit signals are set by default.

® |f you want to hide all XY diagrams at once, use the View menu option. Disable XY Plots
here.

B There is a [XY fc3] label button on the left below the XY diagram. Clicking on this button
opens an information window with details about the correction file currently in use or the
inverse field correction.

Inverse Correction Info

Path CAProgramData\RAYLASE\ProcessDataAnalyzer\CorrectionFiles\inverse_47DEQpj8HBSa+-TImW +5)CeuQeRkmSNMpIWZG3hSuFVIT TvE.fc3
Field Axes XY

Scanner Axes Xy

Dirmeansions 2D

Is GCD? False

Head Format RL3_Single3Dl

Field Size XYZ [um] 141200, 141200, 1
Field Offset XYZ [um] 0,0,0
Max Magnification 1

Layers 257, 257, 1,1

Hash saVezmOKiRf3Uju+x1Lz0hpktuF/2z9421/40kPIREFTTvF

Fig. 6.3: PDA-ABI
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Right-click the mouse in the XY diagram area to open the context menu. You will find
additional functions there:

Measure

Clear measurements

Skip jumps
Highlight position on time plot
Fit to field size
Fit to trajectory
Fit to AB cursor range
Reset aspect to square
L Keep aspect ratio

Save as image

Fig. 6.4: PDA-ABJ

Element

Explanation

Measure

Starts the measurement function. See page 61, Distance measurement tool.

Clear measurements

Deletes all currently displayed measurement vectors including measured values.

Skip jumps

Hides / Shows all jump trajectories in all XY diagrams

Highlight position on
time plot

Enables the display of all points in time at which the selected coordinate of the
trajectory was approached using auxiliary lines in the time diagram. See section
7.4.2

Fit to field size

Fits the viewport to the scan field.

Fit to trajectory

Fits the viewport to the complete trajectory.
NOTE: This also includes hidden jump vectors.

Fit to AB cursor range

Fits the viewport to the trajectory that was travelled in the time between the
two cursors.

Reset aspect to square

Sets the view of the XY diagram to the same scaling of the X and Y axes

Keep aspect ratio

If activated, zoom sections selected with the mouse cursor are always displayed
with the same X and Y scaling. Without this function, the axes may be scaled
differently according to the selection window.

Save as image

Saves the complete time diagram with the currently displayed time span as a
. .
.png file.
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6.4 Navigation in the diagrams

An essential feature of the PDA user interface is that you can view certain temporal or local
events of its laser process in great detail.

To do so, you can enlarge and position the image section of the graphs in the diagrams so
that you can view the desired detail.

The following section describes some options that can be used to emphasize the desired
position of the graph or the desired section of the graph.

6.4.1 Automatic fitting functions

Time diagram

In the time diagram, the X- or time axis is scaled after signal recording stops so that the entire
time span of signal recording uses the available diagram area.

The Y- or value axis is also automatically scaled and shifted so that all recorded data can be
seen.

The context menu in the time diagram also offers the following two functions:
®  Fijt all: Fit all graphs completely into the respective screen sections (per diagram section).

B Fit signal axis: Scale the Y- or value axis for all graphs so that all data in the current time
range is fitted.

XY diagram

In the XY diagram, the view is automatically fitted to the field size.

The context menu in the XY diagram also offers three functions:

® Fit to field size: Fit the image section back to the field size.

® Fit to trajectory: Fit all recorded trajectories into the image section.

B Fit to AB cursor range: The trajectories resulting from the time span between the two A
and B cursors are fitted into the image section.

If you want to fix the scale range predefined for both diagrams for the first view after signal
— recording has been completed, enable the [Lock signal auto-resize] toggle button.
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6.4.2

6.4.3

Zoom

You can use the mouse wheel to zoom in and out in both the time diagram and the XY
diagram. The scale values adjust automatically. The zoom center point corresponds to the
current cursor position in the diagram.

In the case of the time diagram, however, only the time axis is stretched/compressed.

To scale the Y- or value axis of the time diagrams, position the mouse cursor directly at the
scale of the corresponding diagram section and then use the mouse wheel.

You can also hold down the mouse wheel and drag the mouse cursor to a specific area to be
enlarged:

25000

:

171187 [pm]*

:

Field ¥ [um]

5000

Fig. 6.5: PDA-AGH

Shifting scale range

In both axis directions

Hold down the left mouse button and shift the image section by moving the mouse until the
desired area is in the image.

In just one axis direction

Position the mouse cursor on the corresponding diagram scale (indicator: Mouse pointer
changes to hand symbol). Hold down the left mouse button and shift the image section by
moving the mouse until the desired area is in the image.

NOTE: An overview of all the functions for zooming and shifting is displayed at Help > Show
Mouse Controls.
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6.5 “Acquired signals & cursors” panel

Acquired signals 8 cursors *

(5) XY plot overlays

+'| Show commanded signals || Show
Signal Unit XY coloring A T B AAB AAT ATE
Time [ms] ; 1648,60373437 | 431647084375 | 33423746875 | 1693,77095312 | 266786710937 | -974,09615625
+ | [Field Commanded X [mm] ! 858814067082 | -23,087278099 | 8,58814067082( 0 -31,675418770 | 31,6754187701
+|[Field Commanded Y [mm] ; 12,7845158874 | 14,0535738421| 12,7845158874( 0 1,26905795462 | -1,2690579546
| |cate _— 0 1 0 0 1 K
+ || +||Laser Power 16-bit [3a] ;= = = 100 100 100 0 0 0
| [Copy of power 3 ! 100 100 0

Fig. 6.6: PDA-AAI
The Acquired Signals & Cursors panel is arranged over the XY Plots panel by default. It is
divided up in two sections:
B XY plot overlays, see page 56, XY plot overlays.
m  Signals, see page 57, Signals.

6.5.1 XY plot overlays
Select here whether the trajectories to be displayed in the XY diagram should be based on
B The commanded position data (Show commanded signals checkbox) and / or
B The measured position data (Show measured signals checkbox).

If you select both, the trajectories for the corresponding signal are displayed superimposed in
the same diagram.

The cursor labels on the XY diagram are displayed in different colors for both position data.

NOTE: With the communication protocols currently available, it is not possible to receive
measured position data and status information from the deflection unit at the same time.
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6.5.2 Signals

The Signals table lists all actively configured signals and all virtual signals in the order in
which they are listed in the Configurations > Signals menu.

The time is always listed at the top of the table as a separate entity.

Column Explanation
XY Use the checkbox to select whether an XY diagram should be generated and
displayed for the corresponding signal.
TP Use the checkbox to select whether a diagram section should be displayed in the
time diagram for the corresponding signal.
Signal Name of the signal.
Unit Physical unit of the signal, if defined.
XY Coloring Define the color or color gradient for the display of the signal values along the
trajectory here.
For details on color selection, see page 68, Color settings in the XY diagram.
Data value of the respective signal at the position of the A cursor.
T Data value of the respective signal at the position of the T cursor.
Data value of the respective signal at the position of the B cursor.
AAB “Position A cursor” data value minus “Position B cursor” data value.
AAT “Position A cursor” data value minus “Position T cursor” data value.
ATB “Position T cursor” data value minus “Position B cursor” data value.

Tab. 6.1: PDA-024

For more details on the cursor functions and how to use them, see page 60, Time Plot / XY
Plot cursor relationship.
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NOTE: Right-click on the row with the column headings to open the list of all columns. There
you can select or deselect the display of the respective column if necessary:

Signal X Y coloring
Time v P
+ Signal
+" |[Field Commanded X o Unit
«" |[Field Commanded ¥ j ifcclc:rlng
o || W [Cate v
¥ B |
o ||| w*||Laser Power 16-bit v AAB = |
+' | |[Copy of power v AaT
yorp v ATE

Fig. 6.7: PDA-AA)J
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7.1

EVALUATING DATA

Measurement cursor

The time diagram offers three measurement cursors (A, B, T).
The labels for the respective measurement cursors are located above the time diagrams.

B You can “pick up” the A/B cursors either at their label or anywhere with the mouse and
move them to the desired position.

When the cursor has been grabbed, the mouse symbol changes to €.
The corresponding time is also displayed in the labels.

B The measurement cursors can be moved very finely using the keyboard. The increment by
which a cursor moves when an arrow key is clicked can be specified in the default settings.
See also page 66, Preferences.

Cursor Explanations
A cursor Static ® |f you “grab” the cursor in a diagram section and then move it close
B cursor (grey line) to_a vertical signal edge or a data point, the cursor is “attached” to
this edge.
® Hold [Shift]+[A] down to shift the A cursor with the [—] or [«]
arrow keys.
® Hold [Shift]+[B] down to shift the B cursor with the [—] or [«]
arrow keys.
T cursor Dynamic ® The [—] or [«] arrow buttons shift the T cursor.
(yellow line) NOTE: The T cursor is only displayed when the mouse cursor is moving
in the time diagram area.

Tab. 7.1: PDA-025

In each diagram section, the value of the signal graph (value label) is displayed for each

cursor.
Time plot x
| A T B
18 3,181.227 [ms] 4,498.828 [ms] 5,576.483 [ms]
| Plotting of acquired signals as time series.
16
E 14 | 14.808 [mm]
<0 |
o112
i
[
o

Fig. 7.1: PDA-AAK

The values of the measurement cursors and the time spans between the cursor positions are
also listed in the Acquired signals and cursors panel in the Signals table. For details, see

page 57, Signals.
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7.2 Time Plot / XY Plot cursor relationship

One of the main functions in the PROCESS DATA ANALYZER is assigning a temporal event to
a location or field position.

For this purpose, small crosshairs are displayed for the measurement cursors in the XY plot.
Additional information is displayed next to the crosshairs for the respective measurement
cursor (so-called cursor labels):

B The signal value (in the example, Gate signal [True / False]) and
® The exact position coordinates.
NOTE: The size of the crosshairs can be adjusted. See page 66, Preferences.

Gate Laser Power 16-bit %X Timeplot

A T B
-1226 4,382.798 [ms] 4384251 [ms] 4,384,881 [ms]
228

e =
23
E-1234
é 1236
o 23 -12.365 [mm}
& —

242
1244
1245
o -0 [mml]
00z
0

E
=004 ]

004 o

TV ]
g

% -0.08
= \ "
008 -0.071 fmm]
01
on

g

Laser Power (%]
8

1242 124 1238 1236

234 23 23 228 228
wia Field X (mm)

E

Fig. 7.2: PDA-AAL
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7.3 Distance measurement tool

You can use the distance measurement tool to measure distances, times or differences.

Diagram Measurement of ...
XY diagram ®m Distances between positions or trajectories.
Time diagram m Differences in the signal graph (vertical measurement) or
® Times (horizontal measurement) or
m Differences and times together.
Tab. 7.2: PDA-026
... Procedure 1. Position the mouse cursor at the starting point for distance measurement.

2. Right-click to open the context menu. Select the Measure menu item.

3. Move the mouse cursor to the end point of the measurement.

@ As you move the mouse, you will already see the measurement vector.

4. At the end point of the measurement, confirm this by right-clicking the mouse again.

® The dimensions are displayed (length of measurement vector, X component, Y component
of the measurement vector).

NOTES:

B Both the start and end points of the measurement vector can be moved later with the
mouse using drag & drop.

B The measurement vectors remain visible (even with new data recording) until you delete
them using the Clear measurements context menu option.
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Measurement in the XY diagram: Contour deviation between commanded and measured

Example 1:
trajectory
8.5
E 8-
E
}.
=
@
[N
7.5
7
A = 0.284 [mm]
fiy = -0.182 [mm]
len = 0.33
% N B I A A B

Fig. 7.3: PDA-AAM
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Example 2: Measurement in the time diagram: Comparison of the commanded and measured speed
Measurement is done to determine
B By how much the speed is actually reduced due to a polygon delay, and
® How long it takes until this reduced speed is actually reached at the poly-point.

4,000
3.500
?:E jir =ﬂfz.2:9[?r251 'L“ ;fi 1
2.000 L
1.500 . *

1.000 L%

SpeedMeasured [m/s]

Speed [m/s]

0.500
0.000

-0.500

T T T T
43042 43044 43046 43048
Millizacond |
Fig. 7.4: PDA-AAN
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7.4

7.4.1

... Procedure

7.4.2

... Procedure

Functions for dynamic correlation between
time diagram and XY diagram

Centering XY diagram around a point in time

If you can only see a limited section of the trajectory in the XY diagram because the zoom
level is high, you can use this function

B to center this section on an event (position of the T cursor in the time diagram)

® without having to change the zoom level.

1. To do this, position the T cursor at the desired event or point in time.

2. Right-click to open the context menu of the time diagram. Select the Center XY plot
here menu item.

©@ The XY diagram is centerd.

Determining points in time for a trajectory position

If a point of a trajectory has been “approached” several times (i.e. at different times), you can

use this function to determine all the points in time associated with this trajectory position.

You can then analyze the individual points in time in the time diagram.

1. Position the mouse cursor at the desired position of the trajectory in the XY diagram.

2. Right-click to open the context menu of the XY diagram. Select the Highlight position
on time plot menu item.

@ Vertical auxiliary lines are displayed in the time diagram at these points in time to mark
them.
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You can use the button in the [Open the list of position related timestamps] function
bar to open a list with all time stamps and corresponding position.

T e + «
Cast_ 5930069 169254 10214/49274 VRg @al «+- 8@ HAEC
Gate Laser Power 16-bit Output Current X A X Time plot
A
150 [ms]
354 Position related timestamps ~ — o X
Position X/Y [mm]: 7479 / 23113
30 4 # Timestamp [s]
0 197884 —
25
1
Measure 5
20 4 Clear measurerents °
¥ Skip jumps 3
15 | Highlight position on time plot B
Fit to field size
Fit to square
10 4 Reset aspect to square
¥ Keep aspect ratio
T 5 Save as image .
3 3
E s
i)
2 7 3o
=
s
54
-10
15
104
20
154
Gate
20 4 65536
254
65536
-30 4 ]
H
3
265535
T T T T T T T T T T 2
-40 -30 20 -10 0 10 20 30 40 50 -
XV i3 Field X [mm]

Fig. 7.5: PDA-AAO

You can remove the auxiliary lines in the time diagram via the Clear XY center marker(s)

context menu option.
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3 PREFERENCES

You can open the dialogue with Settings > Preferences or using the [F2] quick access
button.

It is divided up in two areas:
® Charts and
B Units.

NOTE: You can change all settings in Preferences, even after recording data. The changes are
also applied directly to existing records.

Preferences

XY-plot endering O Vector (detailed) @ Bitmap (fast) Quality 3 —|— — '

Line thickness 1,0 —|— — -'7 Cursor cross size 5 + —

Time plot min height [px] 150 -+ — Time plot micro step size [ps] | 10 + -

Time ® Auto QO Second [s] O Millisecond [ms] O Microsecond [ps] O 1/64 ps fraction

Field positions O Micrometer [um]  ® Millimeter [mm]

Laser power QO Bit-value O Hex ® Percentage [%] O Fractional

Fig. 8.1: PDA-AAP

Value Explanations
Charts
XY-plot rendering Select whether the trajectories in the XY diagram are rendered as vector or

raster graphics (pixel graphics).
®m  Vectors (detailed)

Rendering as a vector graphic results in a higher level of detail, but requires
more computing power.

For laser processes with a high number of trajectories (e.g. bitmap, fills, etc.),
this rendering variant can result in some time elapsing after the end of the
recording until all data has been completely rendered.

Any shifting or zooming of an image section is then also very slow.
® Bitmap (fast)

Rendering as a raster graphic requires much less computing time, but the
data resolution is less detailed.

The quality of the rendered raster graphic can be set in levels from 1to 5 (1 =
high resolution ... 5 = low resolution).
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Value

Explanations

Line thickness

Define the displayed line width for vector rendering in pixels. The setting range
is from 0.1 to 10.

Cursor cross size

Define the size of the crosshairs here that show the position of the cursors of
the time diagram in the XY diagram.

The default value is 5 pixels

Time plot min height [px]

Define the minimum height of the individual diagram sections in the time
diagram in pixels here.

Default value: 150 Pixel.

Time plot micro step size
[ps]

Define the time span by which a cursor is moved with the arrow keys per button
click.

Units

Define the units or the order of magnitude of the most important parameters here.

Time

You can choose from the following options for the time units:
B Auto: Automatic unit

m Second [s]

. Millisecond [ms]

B Microsecond [us]

® 1/64 us fraction

Field positions

You can choose from the following options for the units of the field positions or
the distances in the field domain:

B Micrometer [um]
®  Millimeter [mm]

Laser power

The laser power can alternatively be specified in the following units:
® Bit-value
B Hex

® Percentage [%]

B Fractional

Tab. 8.1: PDA-027
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RAYLASE"

9 COLOR SETTINGS IN THE XY
DIAGRAM

9.1 Color spectrum
The colors in the PROCESS DATA ANALYZER change the HSL color spectrum.

@ st coior | @ -
50% I = o i—

5 L Opacity
L 50—
A 100 % ol
# | FF1FGCD
Fig. 9.1: PDA-AAS
Coding Explanation
H Hue (color value)
S Saturation (saturation)
L Lumination (brightness)
A Transparency (transparency)
# Color code

Tab. 9.1: PDA-031

© 2024 RAYLASE GmbH

MN_PROCESS DATA ANALYZER [V1.0]

68



9 COLOR SETTINGS IN THE XY DIAGRAM RAY LAS E

9.2 Assigning colors

In the XY diagram, the data values are displayed over the course of the trajectory using the
color or color gradient.

You can open the color settings in the Acquired signals and cursors panel by clicking on
the color bars in the XY Coloring column.

Signal Unit XY coloring
Time [5] -
Field Commanded X [mim] - *
Field Commanded ¥ [mim] —= = L |
i} B Adjust Coloring

Fig. 9.2: PDA-AAV
A dialogue opens that you can use to make color settings on two tabs:
B Commanded XY:
Color settings for the data points of the commanded trajectory.
® Measured XY:

Color settings for the data points of the measured trajectory.

9.2.1 Boolean data

For boolean data (e.g Gate signal) which only have two states, one color is sufficient for each
state.

Commanded XY Measured XY x
Signal Gate
|~ —_— —
I @ I

Fig. 9.3: PDA-AAR

© 2024 RAYLASE GmbH MN_PROCESS DATA ANALYZER [V1.0] 69



9 COLOR SETTINGS IN THE XY DIAGRAM RAY LAS E

9.2.2

9.2.2.1

Data with continuous progression

Settings

The following color settings can be made for data with a continuous gradient.

|

Commanded XY Measured XY X

Signal Laser Power 16-bit

Min/Max [3] 0 100

Color between min/max ® Gradient

el

[ S
B o 8
=

|

IR

Fig. 9.4: PDA-AAQ

Value

Explanation

Signal

Min/Max [%]

Min. and max. data value

Specify the upper and lower limit value between which the data is either
displayed with a color gradient or a fixed color.

®m  Min: All data positions with a value < min are displayed in the min. color.

B Max: All data positions with a value> max are displayed in the max. color.

Min/Max Color

Color selection

For all data points with value < min and value > max.
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Value

Explanation

Color between minlmax — Gradient
Slider for selecting the type of coloring

Slider to the right =
Gradient

The data points between the min. and max. values are displayed with a color
gradient.

The settings for the color gradient appear at the bottom of the dialogue.

Color gradient: Slider for the color gradient settings

The default setting of the slider contains three support points (“gradient stops”)
m | eft = Basic color blue

m  Center = Basic color green

®m Right = Basic color red

adds another support point for the color gradient.

B jeletes a support point.

Slider to the left = Color
between min/max

The data points between the min. and max. values are displayed with only one
color without a color gradient.

Fixed Color

Select a color (or transparent) for all data points.

Tab. 9.2: PDA-029
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9.2.2.2

Signal range: Assigning a color gradient

1. Open the color settings for the selected signal.

2. Make sure that the slider is set to the right to the Gradient setting.
3. In the Color gradient slider, click on the respective support point and then on the color

field at the bottom left.

The following dialogue opens:

Commanded XY Measured XY x
Signal Laser Power 16-bit
hilin R s 1

4. Select the desired color for this support point.

Fig. 9.5: PDA-AAT

5. If needed, add support points or remove undesired support points [ | .

6. Click on v to apply the colur scheme.

NOTE: If you want to enter specific values for the HSL color spectrum, move the slider for the

color value (Hue) to the left .
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9.2.2.3 Signal range: Assigning a fixed color
1. Open the color settings for the selected signal.
2. Make sure that the slider is set to the right to the Color between min/max setting.
3. Then click on the Fixed Color color field.

The following dialogue opens:

Commanded XY Measured XY x

Signal

limd/lax

fim/Mlax Color

Color between m

Fixed Color

=] {1 3

Fig. 9.6: PDA-AAU

4. Select the desired color.

5. Click on v to apply the colur scheme.

NOTE: If you want to enter specific values for the HSL color spectrum, move the slider for the
color value (Hue) to the left .
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9.2.24

Examples

Heat map

Defect map

With color gradient over the entire value range

and max. value

With fixed (transparent) color between min. value

Laser Power 16-hit

Signal
© Min/Max [%] 25 75

Color between min/max Gradient

Fixed Color
-
g ||
i o .

[%]

Gate  Laser Power 16-bit Gate Laser Power 16-bit
40 40 —
30 H 30
20 4 20 o
10 - 10
5 £
E 0+ E o
> >
= =
= E
& &
210 o 10
20 20
30 4 -30
-40 -40 o
T T T T T T ]
-40 -20 0 20 40 -40 -20
MV 3 Field X [mm] XY fc3
Acquired signals & cursors
Acquired signals 8 cursors
Commanded XY  Measured XY
Trigger Info: All data is recorded regardles:
. Signal Laser Power 16-bit
+'| Show commanded signals || Sho
Min/Max [%] 0 100 )
l Signal
) | Color between min/max ® Gradient | +|[Field Commanded X
me
« | [Ficld C ded Y
| [Field Commanded X e el B e bommanee
|| [Gat
+|[Field Commanded Y - 0 [%] [ ] -
vlleae .q_ — |||+ |Laser Power 16-bit
| |[+]|Laser Power 16-bit &) i W

Tab. 9.3: PDA-030
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10 SAVING/LOADING DATA
RECORDINGS

The PDA application saves the data recordings in its own data format (".pdatrace", PDA Trace
File).

These files can also be loaded in other PDA applications.

The menu options are available for this purpose: File > Open or File > Save.
NOTES:

It is also possible to simply record and save the data without a license, e.g. for general
fault analyses.

The PDA application does not need a control card to load a data recording in order to
analyze it.

When a data recording is loaded, an existing connection to the control card is
automatically disconnected.

At the same time, the data recording configuration is loaded.

— This makes it possible to see which signals, trigger settings etc. were set up in the
configuration dialogue.

— Parameters such as field size are also obtained from the file.

Additional XY diagrams can also be generated after loading, provided that the basic
signals have been recorded.

To record new data again, reconnect to the control card using the [Connect] button.
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11 DATA EXPORT

To continue to process the data recorded with PROCESS DATA ANALYZER in other programs,
you can also export this data in generic data formats (*.csv or *.txt).

To do this, use the export dialogue via the File > Export menu option or the [Ctrl]+[E]
quick access buttons.

Export Delimited Data

Signal Unit
| Time Millisecond [ms] -
«"| Field Commanded ¥ | Millimeter [mm] -
«'| Field Commanded ¥ | Millimeter [mm] -
v Gate
«"| Lazer Power 16-bit | Bit-value b

Export all segments

Time [ms] | 311247014 -+ =—| | 3.11247014 -} =—

Decimal () Point (0.0)  (® Comma (0,0)

Empty field replacerment |

Export .csv Export .txt Cancel

Fig. 11.1: PDA-AAZ
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Value Explanation

Signal list

Signal Selection of all signal data to be included in the export.

Unit If necessary, the unit for export can be changed from the display unit.

Settings

Export all segments If enabled: In the case of multi-segment triggered data recording, the data from
all segments is exported.

Time Option to limit the time span for data export.

Decimal Define whether a period or a comma should be used as a decimal separator for

the exported data.

Empty field replacements |Specify a substitution character for empty fields.

[Export .csv] Buttons for exporting the data of the last recording in the respective format.
[Export .txt]

Tab. 11.1: PDA-032

Data recording or data export
® Data recording:

Data recording saves the complete signal and trigger configuration as well as the inverse
field correction. It can be opened and analyzed again in PDA. Transferring to another PDA
user is possible.

® Data export:

Exported data can never be imported back into the PDA. Export the data if it is to be used
in other applications.
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12

NOTES ON USING THE ADC
ADAPTER BOARD

The PDA application can also be used to display data from external sensors with position
resolution. Sensors that obtain light for analyzis from the deflection mirrors are particularly
well suited to this purpose. For example, temperatures of a melt can be measured using
pyrometers or similar sensors.

Any analog output signals from these sensors can be converted into digital signals (16-bit
resolution) using the ADC Adapter boards. The digital signals can be fed in at the SP-ICE-3
control card either at input slots A or B (port A, port B). With the trace buffer function of the
control card, PROCESS DATA ANALYZER can then read out and display the measurement data
of the external sensors.

When connecting the ADC Adapter boards to the SP-ICE-3 control card, please note that the
corresponding input slot still needs to be configured. Use the SP-ICE-3 configuration tool to
do so (component of the SP-ICE-3 software tools).

Pin Status

(e -

" [Teele[nlels e[ [e[s[<]3[=] ¢
E H E E

Cutputs

pu IR EREERREREE 8 () oo
F 1 F T

P OO e[ [

(--:‘I Adapter Settings

| Adapter selected b

| Enable il I

Confg Version 3

Adapter Name  ADCAdapter w |Select only a connected adapter!
Card ID Ow0000ADCA

Vendor 1D OwD000524C

Board Version  Ow0O000Q001

FPGA Version 000000003

C"j' Configuration

Fig. 12.1: PDA-ABA
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... Procedure Connect to the control card using the SP-ICE-3 configuration tool.

Change to the /O tab.

Expand the adapter settings for the corresponding slot (port A/ port B).
In the Adapter Name field, select the ADCAdapter entry.

Enable the Enable checkbox.

& The CardID, VendorID, Board Version and FPGA Version fields are automatically filled
with the data from the EEPROM of the adapter card.

6. Click on the [Upload to card] button to apply the changes.

ui A N o=

NOTES:

B For details on the ADC Adapter board and its plug connections and circuits, see SP-ICE-3
Manual, section 4.4.

®m Recording the data of these channels requires a separate license.

® The analog inputs of the ADC Adapter boards cover a voltage range from -5V to +5V,
which corresponds to a bit range from -32768 bits to +32768 bits.

If the sensor only uses a real range of 0V to +5V, the scale factor is calculated as follows:
5:32768 = 0.00015259.
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13 NOTES ON API INTERFACE

The graphical user interface of the PROCESS DATA ANALYZER only allows the data to be
recorded and analyzed manually.

In order to record, save or export data automatically, there is an optional .NET library for the
programmatic use of some PDA functions.

These basically include:

®  Configuration of signals

® Configuration of trigger options

® Starting and stopping of data recording and
® Saving or exporting of data

Data can also be transmitted to a corresponding client counterpart via the streaming server
while recording is in progress.

For more details, see the ProcessDataAnalyzer APl Manual.chm .
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14 TROUBLESHOOTING

Error

Measure

No connection to the
control card possible.

Check

® Whether the firmware version of the control card and the PDA program
version are compatible.

® On the web interface of the control card, check whether the number of
authorised connections of the control card is set to the value ”"-1" = infinite.

B Whether another application is accessing the trace buffer of the control card
(e.g. SP-ICE-3 tool Virtual Pointer). The trace buffer only grants exclusive
access to one application at a time.

No inverse field
correction possible.

Make sure that a compliant *.FC3 correction file is loaded on the SP-ICE-3
control card.

No live data in the time
diagram.

Recording does not start.
Check your trigger settings, especially the default for the start trigger.

Signals can be seen in the
time diagram, but XY
diagrams show nothing.

Check whether

B At least one of the two checkboxes for commanded or measured trajectories
is checked in the Acquired signals and cursors panel.

B The positions of both the X- and Y-axes were selected at least as the
commanded position for recording.

B The position signals of the X- and Y-axes were only recorded in the scanner
domain.
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Error

Measure

Systematic errors in the
display of the data in the
XY diagram

Example: Bevelled 90° corners that were not commanded in this way.

Gate  Laser Power 16-bit

26 —

24

S20 f ' 1 10.736, 19.383 [mm]

T
& 4 -2 0 2 4 [
Field X [mm]

fc3

It is very likely that the tracking error value for one of the two mirror axes is
incorrect.

To verify this, check the tracking error values at Configurations > Timing.
Check whether the tracking error values are correct on the control card.

If necessary, reload the values from the control card into the PDA application.

Tab. 14.1: PDA-033

NOTE: If you encounter exception errors when using the PDA software, we ask you to provide
RAYLASE with this information for error analysis.

To do so, use the Help > Save Debug Info menu option. Please send the zip folder created in
the process to support@raylase.de.
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15 GLOSSARY

Current Position

Defect map

Diagram section

Heat map

Output Current

Position Error

Status information of the deflection unit that provides the actual position of the
optical axis (deflection mirror, lens) in the scanner domain.

A defect map is a two-dimensional representation of data where deviations are
displayed with local resolution.

All data that is outside defined limits (i.e. below and above two limit values) is
displayed in one color.

This makes it possible to visualize where values of relevant measured variables
have occurred outside the corresponding limits (e.g. temperatures).

Section of the time diagram with its own Y- (value) axis for the temporal
representation of a signal.

A heat map is a two-dimensional, locally resolved representation of all data over
the entire value range.

This data can be visualized using a color index, for example.

Status information of the deflection unit that provides the galvanometer scanner
current consumption.

Since the actual position values of the optical axes always lag behind their target
position, the position error is never zero.

The difference between the internal target position and the current position is
defined as a signed integer.

This measured value can overflow, e.g. if a target jump is made from one end of
the axis to the other. The value is then saturated at -32768 or +32767.

The internal target position does not necessarily correspond to the commanded
position. That is why it cannot be guaranteed that the axis is at a certain
expected position, even if the position error is at or near zero.

This is the case, for instance, if the axis has not yet started up or if an internal
error or a transmission error of the target position has occurred.

With the SL2-100 or RL3-100 protocol, this value is supplied with 20-bit
resolution.

For more details, see Enhanced Protocol Manual.
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RMS Current

Slew Rate Limiter

Target Position

Trace buffer

Status information of the deflection unit, which provides the galvanometer
scanner current consumption averaged over a time of 1.

Software function module on the control electronics of the deflection unit that
limits the maximum target speed.

Status information of the deflection unit that provides the target position of the
optical axis (deflection mirror, lens) in the scanner domain.

Ring buffer of the SP-ICE-3 control card.

The configured signals are temporarily saved here so that they can then be
provided to the PDA software, e.g. for graphical display.

More details on the trace buffer can be found in the SP-ICE-3 Control Card
Manual, section 15.
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2.1

OVERVIEW

SS-IV und SS-V deflection units provide the SL2-100 interface as standard.

The XY2-100 interface can be ordered as an option in addition to the SL2-100 interface.

Digital three-, four- and five-axis system may support the RL3-100-interface.

Using each of these three interfaces the Enhanced Protocol can be used to transmit commands to
and receive extended status information from the deflection unit.

XY2-100 provides 16-bit resolution; SL2-100 and RL3-100 provide 20-bit resolution.

This document describes all supported Enhanced Commands.

XY2-100-E

The XY2-100-E interface provides

A COMMAND channel for each axis (X, Y, Z), transmitting reference positions, occasionally inter-
spersed with control commands, from the control card to the deflection unit.

A RETURN channel for each axis (X, Y, Z), for data sent back from the deflection unit to the control
card.

Common CLK and SYNC signals.

All signals are differential without galvanic isolation.

Electrical Connection

A standard 25-pin-DSUB female connector is used for data transfer on both deflection unit and con-
trol card.

The corresponding cable has all used pins connected one-to-one.

Twisted-pairs are recommended for the differential signals.

Some deflection units (DIG1) have reserved pins for connecting the power supply: these must not be
connected to the control card.
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2 XY2-100-E
2.2 Pinout
Pin Direction Signal Name
1 to deflection unit CLK-
14 to deflection unit CLK+
2 to deflection unit SYNC-
15 to deflection unit SYNC+
3 to deflection unit X COMMAND- (small mirror)
16 to deflection unit X COMMAND+  (small mirror)
4 to deflection unit Y COMMAND-  (large mirror)
17 to deflection unit Y COMMAND+ (large mirror)
5 to deflection unit Z COMMAND-  (focus axis)
18 to deflection unit Z COMMAND+ (focus axis)
6 to control card Y RETURN-
19 to control card Y RETURN+
7 to control card Z RETURN-
20 to control card Z RETURN+
8 to control card X RETURN-
21 to control card X RETURN+
9
22 power supply on deflection unit Optional +15 V for Head
10 (not used for standard SS-IV/V)
23 deflection unit
11 — Signal GND
4 control card
12
25 power supply on deflection unit Optional -15 V for Head
13 (not used for standard SS-IV/V)
shield GND
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2.3

2.4

Differences from other suppliers

In RAYLASE deflection units, the X-axis (smaller) mirror is defined as the one, which the laser beam
hits first.

Some other suppliers define this to be the Y-axis.

Note that the pinout of the XY2-100-E interface on RAYLASE deflection units swaps the positions of
the X- and Y channels compared to the pinout used by other manufacturers.

Consequently, RAYLASE SS-IV/V deflection units can be used immediately as drop-in re-placements
for units from such manufacturers: it is not necessary to swap the X- and Y channels physically at
the connector.

Components

The maximum frequency of the CLK signal is 4 MHz.

2 MHz is recommended.

Recommended line driver is UA9638CD.

Recommended line receiver is MAX3096, UA9637, or AM26LV32.

SL2-100

SL2-100 carries both X- and Y command channels over a single differential wire pair, and both X-
and Y return channels over a second differential pair.

Additional wires are not required for clock or synchronisation.

Return channel synchronisation is independent of the command channel.

SL2-100 is galvanically isolated by transformers. The maximum cable length is 20m.

SL2-100 supports 20-bit resolution.

Enhanced Commands use only the upper 16 bits, and are transmitted in payload bits 19 to 4, with
the 4 LSBs set to 0.
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3.1 Electrical Connection

Both ends of the cable use a male D-SUB connector. Pins 1 and 6 are cross-connected to pins 5 and
9 of the other end, and vice versa.

All other pins must be N/C.

The casing of both connectors must be connected to the cable shield.

9 Pin male 9 Pin male

1 e e e e e e e e e e e e e e e e e e e e e 1

o ]

. \ A — o’

° o Twisted pair 110 Q differential line impedance | © o

8o common shielded 2-LifYCY 2x2x0.2mm?  |8q

9 04 i i . — — = | 04

O = - " —h) 5

Figure 1: Electrical connection SL2-100

3.2 Pinout

Deflection Unit Direction Signal Name Control Card
Pin Pin
1 to deflection unit COMMAND+ 5
6 to deflection unit COMMAND- 9
5 to control card RETURN+ 1
9 to control card RETURN- 6
7,8 GND GND NC
2 output 3.3V NC
case case

4 RL3-100

RL3-100 uses the SL2-100 electrical connection with a higher data rate and a more efficient proto-
col to transfer up to five axes over the SL2-100 cable.
RL3-100 also supports 20-bit resolution.
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5 XY2-100-E FRAME FORMAT

5.1 Frame Timing

A frame consists of 20 bits.

A ‘0" on the SYNC signal indicates the last bit of a frame.

On the command channels, state changes occur with the rising edge of the CLK signal.

On the return channels, state changes occur with the falling edge of the CLK signal.

This means that the return channels are delayed by half a clock period compared to the command
channels.

IR EEHE R R R E N R st
! Channel
| 1 | !
| | | | |
i 1 | I
| leletelalilelelila e el o be el e e Ll i) RETURN-
I ! ! ' ' Channel
: i : :
1 1 1

Figure 2: XY2-100-E Frame Timing

5.2 Frame Structure

Depending on data to be transmitted, the XY2-100-E Protocol defines differently structured frames.
The frames on the command channels can be distinguished from each other clearly due to static
definition of certain header bit-patterns.

The frames on the return channels cannot be distinguished from each other by their header bit-pat-
terns.

However, since the controller card specifies the data type present on each return channel at any
given time, the data format of these frames is also known by the controller card.
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5 XY2-100-E FRAME FORMAT m

5.2.1 Command Channel Frame Types

There are three different command channel frame types:

16 bit position (inherited from XY2-100 without -E)

18 bit position (inherited from XY2-100 without -E, RAYLASE SuperScan and SS-II deflection units)
Command frame (according XY2-100-E specification 8 bit command and 8 bit parameter)

The deflection unit can clearly distinguished between these three frame types due to their differing
ID Byte patterns (12, I1, 10), as illustrated in Figure 3.

The various frame types can appear in any arbitrary order.

The distinction between an 18-bit position frame and a command frame is determined by the differ-

ing parity. This means that under certain circumstances the deflection unit cannot identify parity er-
rors.

The position (D15 - DO or D17 - DO) is interpreted as unsigned integer where DO is the least signifi-
cant bit, and D15 or D17 the most significant bit.

A command frame transports a command byte (C7 - CO) and a related parameter byte (P7 - PO). The

meaning of the parameter byte varies according to the command byte.

WA o
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Figure 3: XY2-100-E Command Channel Frame Types
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5.2.2 Return Channel Frame Types

The return channels carry various data for each deflection unit axis, as requested from time to time
by the control card.

For reasons of backward-compatibility, there are three different frame types, which are not immedi-
ately distinguishable from each other by their structure alone.

Instead, interpretation of the received data frame must be based on the expected format due to the
last sent command.

Figure 4illustrates the three possible return channel frame types.
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Figure 4: XY2-100-E Return Channel Frame Types

5.2.2.1 16 Bit Backward-Compatible Return Data

This differs from the standard 16 Bit Return Data by one control bit at the beginning of the frame.
This frame type is the same as used in RAYLASE analogue deflection units (e.g. SS-Il series).

5.2.2.2 16 Bit Return Data

This is the standard return channel frame type.

5.2.2.3 18 Bit Return Data

This offers a four times higher resolution than the 16-bit frame types.
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5.3

7.1

Mixing of Command Channel Frame Types

Normally, a 16- or 18-bit reference position is sent in each frame to each axis of the deflection unit.
By inserting individual command frames into the data stream, it is possible to influence the behav-
iour of the deflection unit.

During the 10 ps period in which the command frame is being transmitted, no reference position
can be sent to the deflection unit. The latter therefore interpolates the missing position in-formation
from the two nearest neighbouring positions sent by the control card.

SL2 AND RL3 RETURN CHANNEL
FRAME FORMAT

Because SL2-100 and RL3-100 offer 20 bit resolution the returned 16-bit values are left-aligned to
the 20-bit field by shifting them 4 bit to the left.

The lowest 4 bits are set to 0 in most cases. However, some returned values benefit from the in-
creased resolution (e.g. Current Position). In that case, those 4 lower bits contain the least signifi-
cant bits of the 20-bit value, which would get striped in XY2-100.

In contrast to XY2-100-E, SL2-100 and RL3-100 employ only one return channel frame type.

ENHANCED COMMANDS

This chapter describes how the behaviour of the deflection unit can be influenced and how various
status data can be requested using appropriate commands.

Structure of a command

A command consists of two Bytes:
1. Command-Code
2. Parameter

These two Bytes are sent to the deflection unit within a command frame with D15-D8 as command
code and D7-DO0 as parameter.

Up to 256 different command codes are available, but SS-IV/V does not use all of them.

The meaning of the parameter varies depending on the command code.

© 2022 RAYLASE GmbH ENHANCED PROTOCOL MN124-en rev. 6/2022-05-27 12
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7.2 Overview of all Commands
Command |Description Details
Code
0x05 Set Data Source 7.3.1 page 15

Selects the data source for the return channel.

0x0A Save Settings 7.3.2 page 36

Saves current settings so that they persist after rebooting the de-
flection unit.

Affected settings are:

- Selected return data source (Set Data Source)

- Selected tuning (

- Select Tuning)

- Position scale factor (

- Set Position Scale Factor)

- Tracking error range (Set Position Acknowledge Level)
- Interpolation time (

- Set Interpolation Time)

- Mirror Tilt Angle (Set Mirror Tilt Angle)

0x11 Select Tuning 7.3.3 page 36
Selects the current tuning parameters.

The command allows selection from up to three preconfigured
tunings.

Note: the axis is briefly in an undefined state until the se-
lected tuning takes effect.

0x12 Set Position Scale Factor 7.3.4 page 36
Defines the mechanical deflection of the axis.

This command is not supported by SS-IV/V.

0x15 Set Position Acknowledge Level 7.3.5 page 37
Defines the tracking error limit.

If the current tracking error exceeds this value, the PosAck bit in
the status word is cleared.

0x17 Data Source Storage 7.3.6 page 37

Parameter == OxFF: temporarily save the currently selected return
data source.

Parameter == 0x00: the previously saved return data source will
be restored.

© 2022 RAYLASE GmbH ENHANCED PROTOCOL MN124-en rev. 6/2022-05-27 13
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Command
Code

Description

Details

0x21

Set Echo Data
Defines the return data statically based on the given parameter
byte.

The parameter byte is copied unaltered into the upper 8 bits of
return data. The inverted parameter byte is copied into the lower
8 bits of return data.

7.3.7 page 37

0x90

Set Interpolation Time

Defines the interpolation mode and interpolation time.

7.3.8 page 38

0x93

Set Mirror Tilt Angle

Tilts the mirror so that an off-axis laser pointer or camera can
cover the whole field.

7.3.9 page 39

© 2022 RAYLASE GmbH ENHANCED PROTOCOL MN124-en rev. 6/2022-05-27
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7.3

7.3.1

Description of Commands

Set Data Source

This command selects the data source for the return channel.

Except as noted otherwise, all data sources employ 16 Bit Return Data.

Byte

Parameter Data Source Name

Details

0x00 Status Word

7.3.1.1 page 17

0x01 Current Position

7.3.1.2 page 18

0x02 Target Position

7.3.1.3 page 18

0x03 Position Error

7.3.1.4 page 19

0x04 Output Current

7.3.1.5 page 19

0x05 Relative Output Control 7.3.1.6 page 20
0x06 Current Velocity 7.3.1.7 page 20
0x14 Galvanometer Temperature 7.3.1.8 page 20
0x15 Servo Board Temperature 7.3.1.9 page 21

0x17 DSP Core Voltage

7.3.1.10 page 21

0x18 DSP 10 Voltage

7.3.1.11 page 21

0x19 Analog Supply Voltage

7.3.1.12 page 22

O0x1A Main Supply Voltage

7.3.1.13 page 22

Ox1E Serial Number Low

7.3.1.14 page 22

Ox1F Serial Number High

7.3.1.15 page 23

0x20 Article Number Low

7.3.1.16 page 23

0x21 Article Number High

7.3.1.17 page 23

0x22 Firmware Version Number

7.3.1.18 page 24

0x24 Aperture

7.3.1.19 page 24

0x25 Wavelength

7.3.1.20 page 24

0x26 Tuning Selectors

7.3.1.21 page 25

0x27 Data Source Selectors

7.3.1.22 page 25
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Parameter
Byte

Data Source Name

Details

0x28

State Flags Low

7.3.1.23 page 26

0x29

State Flags High

7.3.1.24 page 27

0x2A

Stop Event Code

7.3.1.25 page 28

0x2B

Stop Flags Low

7.3.1.26 page 28

0x2C

Stop Flags High

7.3.1.27 page 29

Ox2F

Running Time Seconds

7.3.1.28 page 29

0x30

Running Time Minutes

7.3.1.29 page 29

0x31

Running Time Hours

7.3.1.30 page 30

0x32

Running Time Days

7.3.1.31 page 30

0x3F

Position Scale

7.3.1.32 page 30

0x40

Position Acknowledge Level

7.3.1.33 page 31

0x50

Loop Control Tracking Error

7.3.1.34 page 31

0x51

Slew Rate Limit

7.3.1.35 page 32

0x55

Root-mean-square Current

7.3.1.36 page 32

0x56

Transfer Delay

7.3.1.37 page 32

0x57

Loop Transfer Delay

7.3.1.38 page 33

0x80

Compatible Status Word
Non-standard!

16 Bit Backward-Compatible Return Data

7.3.1.39 page 33

0x90

Interpolation Time Configuration

7.3.1.40 page 34

0x93

Mirror Tilt Angle

7.3.1.41 page 34

0x98

Auxiliary Temperature Sensor 1

7.3.1.42 page 35

0x99

Auxiliary Temperature Sensor 2

7.3.1.43 page 35

0x9A

Auxiliary Temperature Sensor 3

7.3.1.44 page 35
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7.3.1.1 Status Word

Identifier SetDataSource Parameter
StatusWord 0x00
Range
Minimum Nominal Maximum Data type Unit

- - - 2x unsigned 8 bit -

Description

Equivalent to the status word of the standard XY2-100 (without -E)

The status word consists of 8 bit, which are repeated, in upper and lower Byte.

Bit 15 and bit 7 =1 : axis operational;
=0 :error
Bit 14 and bit 6 = 1: galvo temperature normal;

= 0: galvo temperature error. (SS-IV/V always OK, as this temperature is not

measured)

Bit 13 and bit 5 = 1: like bit 12 and bit 4, but for the Z-axis.

Bit 12 and bit 4 = 1: X-axis position within tracking error limit.
Both bits are also reset when the axis is tilted (see 7.3.9 Set Mirror Tilt Angle,
page 41)

Bit 11 and bit 3 = 1: like bit 12 and bit 4, but for the Y-axis.

Bit 10 and bit 2 = 1: auto calibration sensor inactive (always 1 if no sensor is installed)

Bit 9 and 1 = always 0

Bit 8and 0 = always 1

© 2022 RAYLASE GmbH ENHANCED PROTOCOL MN124-en rev. 6/2022-05-27 17
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7.3.1.2

7.3.1.3

Current Position

Identifier SetDataSource Parameter
CurrentPosition 0x01
Range
Minimum Nominal Maximum Data type Unit
-32768 - 32767 Signed 16 bit -
Description

Current measured position of the mirror as 16 bit signed integer.

0 means that the axis is in the middle of the field.

Provides the current position referenced to the non-tilted centre — even when the axis is tilted (see 7.3.9
Set Mirror Tilt Angle, page 39)

Due to noise, it is possible for the measured value to exceed the available data range. In this case, the re-
turned value saturates at the minimum or maximum possible value.

When using SL2-100 this value has 20-bit resolution.

Target Position

Identifier SetDataSource Parameter
TargetPosition 0x02
Range
Minimum Nominal Maximum Data type Unit
-32768 - 32767 Signed 16 bit -
Description

Internal command position of the mirror as 16 bit signed integer. 0 means that the axis should be in the
middle of the field.

Provides the target position referenced to the non-tilted centre — even when the axis is tilted (see 7.3.9 Set
Mirror Tilt Angle, page 39)

Under certain circumstances (error condition, or shortly after switching on the supply voltage) the internal
target position within the deflection unit may not be equal to the position commanded via XY2-100-E in-
terface.

When using SL2-100 this value has 20-bit resolution.

© 2022 RAYLASE GmbH ENHANCED PROTOCOL
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7.3.14 Position Error
Identifier SetDataSource Parameter
PositionError 0x03
Range
Minimum Nominal Maximum Data type Unit
-32768 - 32767 Signed 16 bit -
Description
A signed integer calculated from Target Position - Current Position. This value can overflow (e.g. when a
jump from one extreme of axis travel to the other is requested), in which case the value saturates
at -32768 or +32767.
Even if this value is close to zero, there is no guarantee that the axis is at the commanded target position
since the internal target position may not conform to the commanded position.
This can occur, for instance, when the axis has not booted yet, or when an internal or transmission error
occurs.
When using SL2-100 this value offers 20-bit resolution.
7.3.1.5 Output Current
Identifier SetDataSource Parameter
OutputCurrent 0x04
Range
Minimum Nominal Maximum Data type Unit
-32768 - 32767 Signed 16 bit mA
Description
The measured galvo current in mA as signed integer. The maximum current can be +-10 A approximately.
This value can be read starting with firmware Rev. 4977.
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7.3.1.6

7.3.1.7

7.3.1.8

Relative Output Control

Identifier SetDataSource Parameter
RelativeOutputControl 0x05
Range
Minimum Nominal Maximum Data type Unit
-32767 - 32767 Signed 16 bit 1732768
Description

The relative output control level in 1/ 32768 parts of full scale. For example a value of 3267 corresponds

t0 (3267 /32678) = 10%.

This value can be read starting with firmware Rev. 4977.

Current Velocity

Identifier SetDataSource Parameter
CurrentVelocity 0x06
Range
Minimum Nominal Maximum Data type Unit
-32768 - 32767 Signed 16 bit bit/ms
Description
The current angular speed of the axis in bit/ms.
In case of under- or overflow, the value will be saturated at -32768 or +32767.
Galvanometer Temperature
Identifier SetDataSource Parameter
GalvanometerTemperature 0x14
Range
Minimum Nominal Maximum Data type Unit
0(0°Q) - 1500 (150 °C) Signed 16 bit 1/10 °C

Description

Values lower than zero indicate that there is not sensor present.

This value can be read starting with firmware Rev. 6972.

The current temperature of the galvanometer scanner as signed integer in 1/10 °C.
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7.3.1.9

7.3.1.10

7.3.1.11

Servo Board Temperature

Identifier SetDataSource Parameter
ServoBoardTemperature 0x15
Range
Minimum Nominal Maximum Data type Unit
-400 (-40 °C) - 1200 (120 °C) Signed 16 bit 1710 °C

Description

The current temperature of the servo board as signed integer in 1/10 °C.

DSP Core Voltage

Identifier SetDataSource Parameter
DSPCoreVoltage 0x17
Range
Minimum Nominal Maximum Data type Unit
1.15V(115) 1.2V (120) 1.25V (125) Signed 16 bit 17100 V
Description

The current core voltage of the processor as signed integer in 1/100 V.

The nominal value is 1.2 V.

DSP 10 Voltage

Identifier SetDataSource Parameter
DSPIOVoltage 0x18
Range
Minimum Nominal Maximum Data type Unit
3.1V (310) 3.3V (330) 3.5V (350) Signed 16 bit 1/100 V
Description

The DSP 10 voltage as signed integer in 1/100 V.

The nominal value is 3.3 V.

© 2022 RAYLASE GmbH ENHANCED PROTOCOL
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7.3.1.12

7.3.1.13

7.3.1.14

Analog Supply Voltage

Identifier SetDataSource Parameter
AnalogSupplyVoltage 0x19
Range
Minimum Nominal Maximum Data type Unit
8V (800) 10 V (1000) 15V (1500) Signed 16 bit 1/100 V
Description
The analog supply voltage as signed integer in 1/100 V.
The nominal value is 10 V.
Main Supply Voltage
Identifier SetDataSource Parameter
MainSupplyVoltage Ox1A
Range
Minimum Nominal Maximum Data type Unit
28V (2800) 33V (3300) or 50 V (5000) Signed 16 bit 17100 V
48 V (4800)
Description
The input supply voltage as signed integer in 1/100 V. The nominal value is 33 V or 48 V.
If the limits are exceeded, the axis is deactivated.
Serial Number Low
Identifier SetDataSource Parameter
SerialNumberLow Ox1E
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit -
Description

The whole 32 bit serial number may be obtained from:
(65536 * Serial Number High) + Serial Number Low

The lower 16-bit word of the deflection unit's 32-bit serial number.
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7.3.1.15

7.3.1.16

7.3.1.17

Serial Number High

Identifier SetDataSource Parameter
SerialNumberHigh Ox1F
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit -
Description
The upper 16-bit word of the deflection unit’s 32 bit serial number.
The whole 32 bit serial number may be obtained from:
(65536 * Serial Number High) + Serial Number Low
Article Number Low
Identifier SetDataSource Parameter
ArticleNumberLow 0x20
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit -
Description
The lower 16-bit word of the deflection unit’s 32-bit article number.
The whole 32 bit article number may be obtained from:
(65536 * Article Number High) + Article Number Low
Article Number High
Identifier SetDataSource Parameter
ArticleNumberHigh 0x21
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit -
Description

The 32 bit article number may be obtained from:
(65536 * Serial Number High) + Article Number Low

The upper 16-bit word of the deflection unit’s 32-bit article number.
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7.3.1.18

7.3.1.19

7.3.1.20

Firmware Version Number

Identifier SetDataSource Parameter
FirmwareVersionNumber 0x22
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit -
Description
The version of the firmware of the axis.
Aperture
Identifier SetDataSource Parameter
Aperture 0x24
Range
Minimum Nominal Maximum Data type Unit
- - - Signed 16 bit mm
Description
The aperture of the mirror on the axis in mm.
Wavelength
Identifier SetDataSource Parameter
Wavelength 0x25
Range
Minimum Nominal Maximum Data type Unit
- - - Signed 16 bit nm
Description

The design wavelength of the mirror coating in nm.
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7.3.1.21

7.3.1.22

Tuning Selectors

Identifier SetDataSource Parameter
TuningSelectors 0x26
Range
Minimum Nominal Maximum Data type Unit
- - - 2x unsigned 8 bit -
Description

booting.

default tuning.

The lower 8 bits (D7 to DO) hold the selector for the currently active tuning.
The active tuning can be selected by the command 7.3.3 Select Tuning, page 36.
The upper 8 bits (D15 to D8) hold the selector for the default tuning which is loaded automatically after

The command Save Settings, 7.3.2 page 36, can be used to make the currently active tuning become the

Data Source Selectors

Identifier SetDataSource Parameter
DataSourceSelectors 0x27
Range
Minimum Nominal Maximum Data type Unit
- - - 2x unsigned 8 bit -
Description

The lower 8 bits (D7 to DO) hold the number of the currently selected return data source.
Consequently, the lower 8 bits are always 0x27.

The upper 8 bits (D15 to D8) hold the selector for the default return data source, which is loaded auto-

matically after booting.

The command Save Settings,7.3.2 page 36, can be used to make the currently selected data source be-

come the default.
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7.3.1.23 State Flags Low

Identifier SetDataSource Parameter
StateFlagsLow 0x28
Range
Minimum Nominal Maximum Data type Unit
- - - Flags 16 bit -
Description
Bit 15 = 1: Output stage active.
Bit 14 = 0: Galvo heating inactive (SS-IV/V has no galvo heating).
Bit 13 = 1: All voltages (including internally generated) within allowed range.
Bit 12 = 1: Tracking error is within the tracking error window (adjustable via 7.3.5
Set Position Acknowledge Level, page 37)
Bit 11 = 1: Servo board temperature normal (i.e. under 80°C)
Bit 10 = 1: Boot process finished.
Bit 9 = 1: No permanent errors.
Bit 8 = 1: External supply voltages OK.
Bit 7 = 1: Servo board temperature normal (i.e. under 80°C).
Bit 6 = 1: ADC initialized.
Bit 5 = 1: Axis is not in a critical position.
Bit 4 = 1: Controller parameters OK.
Bit 3 = 1: Mirror is not tilted (see command 7.3.9 Set Mirror Tilt Angle, page 39).
Bit 2 = 1: Axis in standard control mode
Bit 1 = 1: unused
Bit 0 = 0: Position control of the axis is active.
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7.3.1.24 State Flags High

Identifier SetDataSource Parameter
StateFlagsHigh 0x29
Range
Minimum Nominal Maximum Data type Unit
- - - Flags 16 bit -
Description
Bit 15 = 1: AGC of position detector within allowed range.
Bit 14 = 1: Analog supply voltages OK.
Bit 13 = 1: ADC supply voltage OK (2.5 V)
Bit 12 = 1: DSP supply voltage OK (3.3 V)
Bit 11 = 1: DSP core voltage OK (1.2 V)
Bit 10 = 1: Servo board temperature okay
Bit 9 = 1: Galvo temperature okay
Bit 8 = 1: Measured current of the output stage is in the allowed range.
Bit 7 = 1: Target value of the current of the output stage okay
Bit 6 = 1: unused
Bit 5 = 1: unused
Bit 4 = 1: unused
Bit 3 = 1: unused
Bit 2 = 1: unused
Bit 1 = 1: unused
Bit O = 1: unused
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7.3.1.25 Stop Event Code
Identifier SetDataSource Parameter
StopEventCode 0x2A
Range
Minimum Nominal Maximum Data type Unit
- 0 - Unsigned 16 bit -
Description
The cause of the latest error
0x0000 no error
0x0001 Galvanometer reached a critical edge position (unused)
0x0002 ADC error (unused)
0x0003 Temperature too high.
0x0004 External supply voltage outside allowed range.
0x0005 Invalid flags (unused).
0x0006 — 0x000C Reserved (unused).
0x000D Watchdog (unused)
0x000E Position error excessively high for too long a time (unused)
0x000F Reserved (unused)
0x0010 Error in the current controller of the output stage (transient load too high)
0x0011 — OxXFFFF Unused
7.3.1.26 Stop Flags Low
Identifier SetDataSource Parameter
StopFlagsLow 0x2B
Range
Minimum Nominal Maximum Data type Unit
- - - Flags 16 bit -
Description

The state of the flags (State Flags Low) at the time of the last triggered error state.
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7.3.1.27 Stop Flags High
Identifier SetDataSource Parameter
StopFlagsHigh 0x2C
Range
Minimum Nominal Maximum Data type Unit
- - - Flags 16 bit -
Description

The state of flags (State Flags High) at the time of the last triggered error state.

7.3.1.28 Running Time Seconds
Identifier SetDataSource Parameter
RunningTimeSeconds Ox2F
Range
Minimum Nominal Maximum Data type Unit
0 - 59 Signed 16 bit seconds
Description

The seconds part of the total running time of the axis.

This value is incremented once per second up to 59, at which point a carry over to Running Time Minutes

occurs, and the value is reset to 0.

The total running time of the axis is persistent over power cycles.
7.3.1.29 Running Time Minutes

Identifier SetDataSource Parameter
RunningTimeMinutes 0x30
Range
Minimum Nominal Maximum Data type Unit
0 - 59 Signed 16 bit minutes
Description

The minutes part of the total running time of the axis.

This value is incremented once per minute up to 59, at which point a carry over to Running Time Hours,
page 30, occurs, and the value is reset to 0.

The total running time of the axis is persistent over power cycles.
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7.3.1.30

7.3.1.31

7.3.1.32

Running Time Hours

Identifier SetDataSource Parameter
RunningTimeHours 0x31
Range
Minimum Nominal Maximum Data type Unit
0 - 23 Signed 16 bit hours
Description

The hours part of the total running time of the axis.

This value is incremented once per hour up to 23, at which point a carry over to 7.3.1.31 Running Time

Days, page 30, occurs - and the value is reset to 0.

The total running time of the axis is persistent over power cycles.

Running Time Days

Identifier SetDataSource Parameter
RunningTimeDays 0x32
Range
Minimum Nominal Maximum Data type Unit
0 - 32767 Signed 16 bit days
Description
The days part of the total running time of the axis.
This value is incremented once per day.
The total running time of the axis is persistent over power cycles.
Position Scale
Identifier SetDataSource Parameter
Position Scale 0x3F
Range
Minimum Nominal Maximum Data type Unit
- 0 - Signed 16 bit -
Description
Not supported
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7.3.1.33 Position Acknowledge Level

Identifier SetDataSource Parameter
PositionAcknowledgeLevel 0x40
Range
Minimum Nominal Maximum Data type Unit

- - - 2x unsigned 8 bit -

Description

The lower 8 bits (D7 to DO) hold the currently set Position Acknowledge Level.

The configuration of the Position Acknowledge Level is described in 7.3.5 Set Position Acknowledge Level,
page 37.

The upper 8 bits (D15 to D8) reflect the default Position Acknowledge Level that is automatically loaded
after switching on the supply voltage of the axis.

The command 7.3.2, Save Settings, page 36, can be used to store the currently set Position Acknowledge
Level as the default to be loaded automatically after booting.

7.3.1.34 Loop Control Tracking Error

Identifier SetDataSource Parameter
CtrlTrackingError 0x50
Range
Minimum Nominal Maximum Data type Unit
Range
Description

Returns the tracking error of the position loop controller in microseconds. It only reports the tracking error
of the loop controller itself and does not include the transfer delay of the position demand to the loop
controller.

This value can be read starting with firmware Rev. 6972.
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7.3.1.35

7.3.1.36

7.3.1.37

Slew Rate Limit

Identifier SetDataSource Parameter
SlewRateLimit 0x51
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit increments / ms
Description

sponds to a full field per millisecond.

corresponds to a full field per millisecond.

This value can be read starting with firmware Rev. 6972.

Returns the maximum velocity in position increments per millisecond. If the velocity of the commanded
position is larger that this value the velocity gets limited to this value.

When interpreted as a 16 bit value the maximum velocity is 65535 (2A16-1) increments / ms which corre-

When interpreted as a 20 bit value the maximum velocity is 1048575 (2A20-1) increments / ms which also

Root-mean-square Current

Identifier SetDataSource Parameter
RmsCurrent 0x55
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit mA
Description

This value can be read starting with firmware Rev. 6972.

Returns the measured root mean square galvo current of the last second in milliampere.

Transfer Delay

Identifier SetDataSource Parameter
TransferDelay 0x56
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit us
Description

controller in microseconds.

This value can be read starting with firmware Rev. 6972.

Returns the XY2-, SL2- and RL3-protocol position transfer delay between the control card and the loop
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7.3.1.38 Loop Transfer Delay

Identifier SetDataSource Parameter
LoopTransferDelay 0x57
Range
Minimum Nominal Maximum Data type Unit
- - - Unsigned 16 bit us
Description

Returns XY2, SL2 and RL3 protocol delay that elapses between the moment when position command is
sent to the loop controller and the moment when this position command is received by the controller card

via feedback channel.

This value can be read starting with firmware Rev. 6972.

7.3.1.39 Compatible Status Word

Identifier SetDataSource Parameter
Compatible Status Word 0x80
Range
Minimum Nominal Maximum Data type Unit

- - 2x unsigned 8 bit, -

SS-Il compatible
frame format

Description

Conforms to the status word of the standard XY2-100 (without -E).

The only difference from Status Word is that the 16 Bit Backward-Compatible Return Data frame is used
instead of 16 Bit Return Data frame.

The return data are identical to those of the SS-II.

The meaning and the function of the data bits are identical to those provided by 7.3.1.1 Status Word,
page 17.
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7.3.1.40 Interpolation Time Configuration

Identifier SetDataSource Parameter
InterpolationTimeConfiguration 0x90
Range
Minimum Nominal Maximum Data type Unit

- - - 2x Unsigned 8 bit

Description

The lower 8 bits (D7 to DO) hold the currently set interpolation time.
The upper 8 bits (D15 to D8) hold the default interpolation time, which is loaded automatically after boot-
ing.

The command 7.3.2 Save Settings, page 36, can be used to store the current interpolation time as the de-
fault.

The current interpolation time can be set with the command 7.3.8 Set Interpolation Time, page 38. The
significance of the bits in both returned bytes is also described there.

7.3.1.41 Mirror Tilt Angle

Identifier SetDataSource Parameter
MirrorTiltAngle 0x93
Range
Minimum Nominal Maximum Data type Unit
Dependent on axis High Byte: O Dependent on axis 2 x signed 8 bit 1/128 of total de-
and scan head type | | o\ Byte: depend- | and scan head type flection
ent on scan head
type

Description

The lower 8 bits (D7 to DO) contain the current tilt angle of the axis.

The tilt angle can be set with the command 7.3.9 Set Mirror Tilt Angle, page 39.
The upper 8 bits (D15 to D8) are reserved.

After booting, the axis is not tilted.
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7.3.1.42

7.3.1.43

7.3.1.44

Auxiliary Temperature Sensor 1

Identifier SetDataSource Parameter
AuxTemp 0x98
Range
Minimum Nominal Maximum Data type Unit
0(0°Q) - 1200 (120 °C) Signed 16 bit 1710 °C

Description

The current temperature of the first auxiliary temperature sensor as signed integer in 1/10 °C. Values
lower than zero indicate that there is not sensor present.

Auxiliary Temperature Sensor 2

Identifier SetDataSource Parameter
AuxTemp2 0x99
Range
Minimum Nominal Maximum Data type Unit
0(0°C) - 1200 (120 °C) Signed 16 bit 1/10 °C

Description

The current temperature of the second auxiliary temperature sensor as signed integer in 1/10 °C. Values
lower than zero indicate that there is not sensor present.

Auxiliary Temperature Sensor 3

Identifier SetDataSource Parameter
AuxTemp3 0x9A
Range
Minimum Nominal Maximum Data type Unit
0(0°C) - 1200 (120 °C) Signed 16 bit 1/10 °C

Description

The current temperature of the third auxiliary temperature sensor as signed integer in 1/10 °C. Values
lower than zero indicate that there is not sensor present.
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7.3.2 Save Settings

Identifier Command Code

SaveSettings 0x0A

Description

Saves the current settings as defaults in order to make them available after re-booting the deflection unit.
Following settings are saved:

- Selected data source return channel 7.3.1 Set Data Source, page 15)

- Selected tuning set (7.3.3 Select Tuning, page 36)

- Current position scaling factor (7.3.4 Set Position Scale Factor, page 36)

- Limit of the tracking error (7.3.5 Set Position Acknowledge Level, page 37)
- Interpolation time (7.3.8 Set Interpolation Time, page 38)

- Mirror Tilt Angle (7.3.9 Set Mirror Tilt Angle, page 39)

In order to execute this command, 0x00 must be sent as parameter. Thus, the 16 bit payload of the com-
mand frame must be exactly 0x0AQO.

This command can be executed during normal operating mode without interrupting the axis movement.

7.3.3 Select Tuning

Identifier Command Code

SelectTuning 0x11

Description

This command allows different tuning sets to be selected. The tuning sets are optionally pre-configured by
RAYLASE.

The goal of different tuning sets is to adjust the dynamic behaviour of the deflection unit during opera-
tion.

The SS-IV/V series can support up to three different tuning sets. The selector for the desired tuning set
should be passed in the parameter. Valid parameter values are 0, 1 and 2. All the other parameter values
are ignored.

Tunings cannot be switched dynamically: when Select Tuning is received, the servo controller is stopped
and then restarted with the new parameters.

The return data source 7.3.1.21 Tuning Selectors, page 25, provides the currently set tuning and the de-
fault tuning, which is loaded automatically after booting.

7.3.2 Save Settings, page 36, can be used to make the currently selected tuning become the default.

7.3.4 Set Position Scale Factor
This command is not supported by SS-IV/V.
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7.3.5 Set Position Acknowledge Level

Identifier Command Code

SetPositionAcknowledgeLevel 0x15

Description

This command specifies the tracking error window.
The default value is 183 (equal to 0.28% of the axis range).

If the position error exceeds the tracking error window, PosAck bits are reset to 0 in the return data
sources

- 7.3.1.1 Status Word, page 17,

- 7.3.1.23 State Flags Low, page 26, and

- 7.3.1.39 Compatible Status Word, page 33.

The current position error can be requested from the return data source 7.3.1.4 Position Error, page 19.

7.3.6 Data Source Storage

Identifier Command Code

DataSourceStorage 0x17

Description

The action performed by this command depends on the parameter:

Parameter Action

0x00 Saves the current return channel data source temporarily.

(NB: only until the axis is rebooted)

OxFF Restores the return channel data source, which was previously saved.

7.3.7 Set Echo Data

Identifier Command Code

SetEchoData 0x21

Description

This command specifies the returned data directly.

The upper 8 bits of the returned data are set equal to the parameter byte.
The lower 8 bits of the returned data are set equal to the complement of the parameter byte.

With this command, the XY2-100-E interface can be tested for transmission errors.
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7.3.8 Set Interpolation Time

Identifier Command Code

SetInterpolationTime 0x90

Description

This command sets the configuration of the interpolation of target positions for the axes. The meaning of
the individual bits of the parameter byte is described in the table below.

The current interpolation configuration can be obtained from the return data source 7.3.1.40 Interpola-
tion Time Configuration, page 34.

The configuration can be saved permanently with the command Save Settings, page 36.
IMPORTANT NOTE for SS-IV/V:

- The configuration sent to the Y-axis is used for both X and Y-axes.
- Any separate configuration sent to the X-axis will be ignored.

Bit 7 down to 1

Interpolation time in steps of 2 micro seconds

(0 =>0us, 1 =>2us, ..., 127 => 254ps)

When target positions are sent via XY2-100-E at shorter intervals than specified here,
linear interpolation between neighbouring target positions is performed.

Note, however, that all movements of the axis are delayed by the specified interpola-
tion time. The total tracking delay time is increased by this amount.

The effective tracking delay of the position controller itself does not change. Corners
of marked objects, for instance, do not become rounded; they are simply marked
slightly later. If necessary, the laser delay times should be adjusted.

Default: 120us (60)

Bit O

If this bit is set to '1', single repetitions of target positions are ignored.

This is necessary when using SP-ICE-1 PCI PRO or SP-ICE-2 control cards with SS-IV/V,
since these cards transmit each target position twice consecutively. If both identical
target positions were considered in the interpolation, the interpolated positions
would proceed in steps rather than smoothly.

For control cards, which do not send double position data it does not matter, if this
mode is active (bit set to '1') as the second target position is ignored only if it is iden-
tical to the previous one.

Default: '1' (active)
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7.3.9

Set Mirror Tilt Angle

Identifier

Command Code

SetMirrorTiltAngle

0x93

Description

This command allows compensation of the position offset resulting from an off-axis laser pointer or

camera.

The 8-bit parameter of this command is signed integer. The value range is -128 to +127. The unit is 1/128
of the complete deflection range, which for RAYLASE heads usually is +/- 22.5 ° optical. However, in order

to avoid mirror collisions the possible tilt range is limited dependent on the deflection unit type.

The currently set tilt angle can be retrieved from the return data source 7.3.1.41 Mirror Tilt Angle,

page 34.

After booting the scan head, the axis is not tilted.

Concerning tilt angle the following return data sources are of interest:

Data Source

Section

Page

Effect

Status Word

7.3.11

17

Compatible Status Word

7.3.1.39

33

Tracking error bit will be reset if the axis is
tilted.

State Flags Low

7.3.1.23

26

Bit 3 will be reset if the axis is tilted. The
tracking error bit (bit 12) is not affected.

Mirror Tilt Angle

7.3.1.41

34

Returns currently effective tilt angle

Current Position

7.3.1.2

18

Provides the current position referenced
to the non-tilted centre — even when the
axis is tilted.

Therefore, this signal can be used for po-
sition verification.

At the edge of the field, the signal will be
saturated.

Target Position

7.3.13

18

Provides the target position referenced to
the non-tilted centre — even when the axis
is tilted.

At the edge of the field, the signal will be
saturated.

Position Error

7314

19

Provides the tracking error of the control-
ler always. This signal is therefore not suit-
able for position verification.
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8

STATUS-LEDS (SS-IV ONLY)

X pat X Warn

LED Label

Description

Y Par Err
X Par Err

Flashes red if a parity error on the Y or X channel of the XY2-100-E or SL2-100 is de-
tected. The flash duration is extended so that even single frame errors are visible.

Both LEDs light continuously if no correct frames are received on either XY2-100-E or
SL2-100 interface.

If frames are received on both XY2-100-E and SL2-100 interfaces, both LEDs blink alter-
nately with a half second period.

Y Dat
X Dat

Flashes yellow when the frame content on the Y or X channel of the XY2-100-E or SL2-
100 interface changes. The flash duration is extended so that even single frame
changes are visible.

Y Err
X Err

Lights red if the Y or X-axis reports an error and while the scan head is booting.

If X/Y OK and X/Y Err LEDs light both at the same time an internal error has occurred.

Y OK
X OK

Lights green if the Y or X-axis is operational.
If X/Y OK and X/Y Err LEDs light both at the same time an internal error has occurred.

Y Warn
X Warn

Lights yellow if the Y or X amplifier reaches the maximum duty cycle.

This means that the marking job is too demanding for the deflection unit at the sup-
plied operating voltage.

To solve the problem, either increase the supplied voltage to 48 V, reduce the marking
velocity, or accept inferior marking quality.

Vin OK

Lights green when the power supply is connected (30 V or 48 V)

V Amp OK

Lights green if output stage supply voltage is OK.
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9 USAGE OF THE PILOT LASER

A SS-IV with the option Mirror Tilt, combined with a digital LTM (Linear Translator Module) with the
optional Laser Pointer, allows the laser pointer to be coupled into the optical path without addi-
tional optics.

In order to use this feature, a sequence of commands must be sent to the X, Y, and Z-axes.

9.1 Activation sequence for the laser pointer
Command or Description
Return Data Source
1 | Status Word Verify that X, Y, and Z axes are error free.
(7.3.1.1 page 17) The retrieved status for all three axes must match the bit pattern in the follow-
ing table.
Bits marked with “X" can be ignored.
Bit(15({14(13|12(11|10| 9 |8 |7 |6 |5 (4 |3 (2|10
E|T|Z|X|Y|F|O|1|E|T|Z|X|Y|F|O0]1
X T[T [ X[ X[X|X]O[T] 1] T[X]|X[|X|X]0]1
Y| T[T [ X|X[X|X]O[T] 1] T|X]|X[|X|X]0]1
Z |1 (1| XX X[ X]O0O[ 1] T[T X|X|X|[X]O0]|1
2 | Set Mirror Tilt Angle Set tilt angle for X- and Y-axes.
(7.3.9 page 39)
3 | Mirror Tilt Angle Verify that axes have accepted the tilt command.
(7.3.1.41 page 34) Wait until the low bytes of the X- and Y-axes show the requested tilt angle.
High-Byte Low-Byte
X-axis To be ignored X tilt angle
Y-axis To be ignored Y tilt angle
4 | Position Error Verify that the axes have reached the tilted position.
(7.3.1.4 page 19)19 The absolute value of the position error of the X- and Y-axes must be smaller
than the expected maximum error.
The retrieved values are 16 bit signed integers.
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Command or Description
Return Data Source

5 | Status Word Verify that X, Y, and Z axes are error free.
(7.3.1.1 page 17) The retrieved status for all three axes must match the bit pattern in the follow-
ing table.

Bits marked with “X" can be ignored.

Bit(15/14|13(12|/11|10/ 9 | 8 |7 | 6 | 5|4 3|2 |1|0

E(T|Z X|Y|F|0|1|E|T Z X Y|F|O0]1
X[1T][1 [ X]0o|X|[X|]O0o]1T|1T|1 | X|0|[X|X]O0]1
Y[ T[T [ X | X]O0O|[X|]O0O]1T| 1|1 X|X[][0]X]O0]|1

6 | Set Mirror Tilt Angle Activate the laser pointer by sending command Set Mirror Tilt Angle with pa-
(7.3.9 page 39) rameter Ox01 to the Z-axis.

7 | Mirror Tilt Angle Verify that the laser pointer activation command has been accepted by the

(7.3.1.41 page 34) Z-axis.
Wait until the low-byte of the return data of the Z-axis provides the value 0x01.

High-Byte Low-Byte
Z-axis To be ignored 0x01
8 | Status Word Verify that X, Y, and Z axes are error free.
(7.3.1.1 page 17) The retrieved status for all three axes must match the bit pattern in the follow-

ing table.

Bits marked with “X" can be ignored.

Bit| 15/14|13(12|11|10|/ 9 8 |7 | 6 | 5|4 3|2 |10

E, T,Z X|Y F|O0|1|E|T|Z|X|Y|F 0 1
X[ 1[1 ] X]0[X|X|]0] 1| 1|1 X[|0[|X]|X]O0]|1
Y[ 1T [T | X|X|]O0|X|O0O]|1T | 1| 1T | X[|X[|[0]X]O0]1
Z | 1|10 | X[ X X|0 1T 1|10 |X|X]|X]O0]|1
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9.2 Deactivation sequence for the laser pointer

Command or Description
Return Data Source

1 | Status Word Check that X, Y, and Z axes are error free.
(7.3.1.1 page 17) The retrieved status for all three axes must match the bit pattern in the follow-
ing table.

Bits marked with “X" can be ignored.

Bit| 15/14|13(12|11|10|/ 9 8 |7 |/ 6 | 5|4 3|2 |10

E|T|Z X|Y|F 0|1 E|T | Z|X|Y|F|O0]1

X[ 1T [ 1T X]| X[ X|X]0] 1T |11 X|X[|X]|X]0]1

Y 1|1 | X X| X/ X001 |11 | X| X|X|X|0]|1

Z 1|1 X X[ X[ X[O0 1T [ 1] 1| X[ X|X]X]0]1

2 | Set Mirror Tilt Angle Deactivate the laser pointer by sending command Set Mirror Tilt Angle with pa-

(7.3.9 page 39) rameter 0x00 to the Z-axis.
3 | Mirror Tilt Angle Verify that the laser pointer has been deactivated.
(7.3.1.41 page 34) Wait until the low-byte of the return channel of the Z-axis provides the value 0.
High-Byte Low-Byte
To be ignored 0x00

4 | Set Mirror Tilt Angle Reset the tilt angle for X- and Y-axes to zero.
(7.3.9 page 39)

5 | Mirror Tilt Angle Verify that the tilt command has been accepted by the axes.
(7.3.1.41 page 34) Wait until the Low-Bytes of the X- and Y-axes show the value zero.

High-Byte Low-Byte

To be ignored 0x00
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Command or
Return Data Source

Description

6 | Status Word
(7.3.1.1 page 17)

Check that X, Y, and Z axes are error free.

The retrieved status for all three axes must match the bit pattern in the follow-
ing table.

Bits marked with “X" can be ignored.

Bit|15/14/13|12/11 /10, 9 | 8 (7 |6 |5 |4 |3 |2 |1/|0

E|T|Z X|Y F|0|1|E|T|Z|X|Y|F 0|1

X[ 1T]1T ] X]|1T]|X|X]0]1 1117 X ] 1| X | X|0]1

Y T[T [ X[ X[ 1T [X]0 [T 1|1 [ X|X[1|X]|0]1

Z |1 |1 [ X|X|X|X]0]1 11T XX | X[ X]0]1
Explanation:

The X- and Y-axes must reach the correct “non-tilted” position.
Therefore, the PosAck bits for X- and Y-axes must be “1".

The PosAck bit for the Z-axis may stay at “0” since the Z-axis has a larger track-
ing error.
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10 COMMAND LOCKING

If certain enhanced-commands are executed accidentally, the marking result may well be adversely
affected.

To help prevent accidental execution, a locking mechanism is supported, starting with firmware ver-
sion 5726.

This requires that a specific unlock sequence is executed before any of the protected commands can
be executed. After this, a lock sequence should be executed to protect against accidental execution
again.

10.1 Protected Commands

Save Settings, chapter 7.3.2 on page 36

Select Tuning, chapter 7.3.3 on page 36

Set Position Scale Factor, chapter 7.3.4 on page 36
Set Interpolation Time, chapter 7.3.8 on page 38

o & N~

Set Mirror Tilt Angle, chapter 7.3.9 on page 39
10.2 Unlock Sequence
The following enhanced-commands must be executed in the exact order shown:
0x1C10, 0x02D5, 0x03A2, 0x0458, 0x1300
Repetition of individual commands is permitted as long as the order is kept.
10.3 Lock Sequence
The following enhanced-commands must be executed in the exact order shown:
0x0100, 0x1300

Repetition of individual commands is permitted as long as the order is kept.

© 2022 RAYLASE GmbH ENHANCED PROTOCOL MN124-en rev. 6/2022-05-27 45



10 COMMAND LOCKING m

10.4 Example (Tuning Switch)

0x1C10 (Unlock Sequence part 1
0x02D5 (
0x03A2 (Unlock Sequence part 3
0x0458 (Unlock Sequence part 4)

)
Unlock Sequence part 2)
)

0x1300 (Unlock Sequence part 5)

0x0100 (Lock Sequence part 1)

© N o ok~ DN =2

(
(
0x1101 (Switch to Tuning 1; Select Tuning, chapter 7.3.3 on page 36)
(
(

0x1300 (Lock Sequence part 2)
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